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Introduction to What's New 

This edition of the "What's New" describes many notable new features and enhancements in 

version 10.97.1 since the previous release (10.97). For information on features and 

enhancements made in earlier versions, see the appropriate "What's New" document for 

those versions. 

 

For information on fixes made in version 10.97.1, see the appropriate "Resolved Issues" 

document.  

 

Note that if updates need to be made, the most up to date "What's New" and "Resolved 

Issues" documents can be found in our online documentation here:  

 

Release Notes 

 

This copy was updated in December 2021. 

Structure of the Document 

This document is split into two main sections, one for major updates that contain 

significant explanation and another for smaller additional enhancements and features 

that are listed in a table. Each section is broken down further into the different areas of 

the ICONICS Suite, then further into sections for major updates. 

Where appropriate, references to additional information, such as instructional 

application notes or help files, will be indicated. 

Security Vulnerabilities 

Information about security vulnerabilities will not be found in this document. For this 

information, refer to iconics.com/cert. 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Intro/Release_Notes.htm
https://iconics.com/cert
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Most Notable Features 

Some of the most notable new features in 10.97.1 are listed below. Visit each link to 

learn more and see the "Major Enhancements" section for additional notable features. 

• New Hyper Alarm Logger for improved alarm logging 

• Technical Preview of the BACnet with SC Point Manager, designed for ASHRAE 

135-2020 and Secure Connect 

• Mitsubishi Electric FA Connector has support for additional PLC and GOT series 

• OPC UA structured variables 

• CFSWorX & AlertWorX: 

o New alert methods: 

▪ Microsoft Azure Communications Services SMS 

▪ Sendinblue email 

o Acknowledgement support for FDDWorX, Hyper Alarming, and OPC UA 

o Display geofences and replay worker paths in EarthWorX 

• Execute commands on GraphWorX64 events, adding more user-friendly and 

easier to maintain options to replace scripting that work in both desktop (WPF) 

and HTML5 

• Technical Preview of 3D viewer support in HTML5 WebHMI and MobileHMI 

displays 

• Internet of Things: 

o MQTT Sparkplug Connector 

o IoTWorX simplified initial setup 

o Takebishi DeviceGateway OPC UA Server 

o Hyper Alarm Server publishing  

• AnalytiX-BI: 

o Performance enhancements 

o Expanded query functionality 

o Parameterized views 

• ReportWorX64: 

o Create predefined parameters for all templates 

o Preconfigured parameters for common use cases 

o Allow users to select a tag as a parameter value 
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Major Enhancements 

Common & Platform Services 

Installation 

Language Pack Included in Release 

Previous versions of ICONICS Suite could be localized into several additional languages, 

but it required the application of an additional language pack or rollup. 

Version 10.97.1 eliminates the need for this additional installation. Simply choose the 

Language Pack option during installation and the necessary files to display ICONICS 

Suite in another language will be installed. The language pack installs all available 

localization files, and the software will use the language that matches the operating 

system, where available. 

These languages are included in the language pack: 

• French 

• Japanese 

• Russian (runtime only) 

Secure By Default Installation Secures UA Server 

(Reference ID: 63708) 

Starting in version 10.97, ICONICS Suite helps users be more security conscious by 

installing in a secure mode by default. For a secure system, ICONICS recommends 

closing as many channels into the system as possible, only leaving open channels that 

are being used. The secure installation helps users adhere to this design methodology 

by requiring them to act to open only the channels they need. 

New in version 10.97.1, when performing a secure installation, the FrameWorX OPC UA 

Server interface is now disabled by default.  

The FrameWorX OPC UA Server is designed to allow third party OPC UA clients to 

retrieve data from FrameWorX and the ICONICS system. Closing this channel by default 

prevents a potential avenue of access for malicious users. ICONICS recommends closing 

this channel on systems where it is not being used. 

Users who have third party OPC UA clients that need FrameWorX access can reenable 

the OPC UA server with these steps: 
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1) Open Platform Services Configuration from either Start > ICONICS Tools or 

Workbench > Tools. 

2) Go to the Basic tab. 

3) Select Enable OPC UA interface. 

Alternatively, users who need the OPC UA interface enabled can choose to install in 

demonstration mode by selecting I want to install a demonstration system during the 

installation. A demonstration installation provides a less secure but easier to use system, 

so it is ideal for users who wish to secure things on their own or simply wish to try out 

the features of ICONICS Suite without worrying about security. 

For Further Reference 

• Help: Configuring OPC UA Servers in FrameWorX Server 

Security 

Use Commanding and Datasets to Configure Security in Runtime 

(Reference IDs: 83132, 83133) 

It is now possible, with the correct permissions, to perform common security 

administrative functions in GraphWorX64 displays or other runtime areas. System 

designers can now create their own interfaces to give security administrators the tools 

they need without having to open Workbench. 

To display information about the current security configuration, use the datasets under 

Diagnostic > Configuration > Security. There are two datasets, one to show security 

groups and another to show security users: 

• SecRole - All – This dataset contains information about all groups in the security 

configuration. 

o Example tag name: cfg:entities/readall<SEC,SecRole> 

• SecUser - All – This dataset contains information about all users in the security 

configuration. 

o Example tag name: cfg:entities/readall<SEC,SecUser> 

These datasets can be displayed in a GridWorX Viewer or table control. More advanced 

users can select individual cells of the dataset to display in a process point and leverage 

the clone dynamic in GraphWorX64 to create more customized views. 

The datasets are secured using the same application actions that control whether a user 

can browse, edit, or delete security items. You can grant or revoke these privileges in the 

Application Actions section of a user or group under Workbench > Security.  

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Arch/DA/Configuring_OPC-UA_Servers_in_FrameWorX_Server.htm
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A new command, Configure Security was added. This command can perform several 

different functions, based on the value of the Action parameter: 

• CreateUser – Creates a new security user with the given username, group, policy, 

and password. 

• ChangePassword – Changes the password of the given security user. Note, this 

command is designed to be used by a security administrator to change the 

password of other users. It does not require the previous password. Users looking 

to change their own password should use the Change Password button in the 

security login dialog. 

• AddUser – Adds a security user to a group. 

• RemoveUser – Removes a security user from a group. 

The Password parameter of the CreateUser and ChangePassword actions must take a 

hashed password. Plaintext passwords are not supported. To hash a password, the new 

Password and PasswordHashing properties of GraphWorX64 process points must be 

used. (For more information on the new password masking feature, see the entry for 

reference ID 11122 in the Additional Enhancements section.) 

The CreateUser, AddUser, and RemoveUser actions can only work with one group at a 

time. To add a user to multiple groups, use the Batch command and call the 

ConfigureSecurity command multiple times. 

Follow these example steps to create an example display that allows a security 

administrator to add a new user: 

1) Add these four labels (text) to a GraphWorX64 display: 

a. Username 

b. Group 

c. Policy 

d. Password 

2) Next to each label, add a data entry process point. (There should be four process 

points in total.) Connect each process point's data source to these local variables: 

a. Username: localsim::user:String 

b. Group: localsim::group:String 

c. Policy: localsim::policy:String 

d. Password: localsim::password:String 

3) If you are not already in Advanced Mode, go to View > Application Mode > 

Advanced Mode. 

4) For the process point next to the Password label, set these properties: 

a. Password to True 

b. PasswordHashing to Password-Based Key Derivation Function 2 
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5) Add a button and label it, Create. 

6) Configure the button's pick action with these properties: 

a. Command to Configure Security 

b. Action to CreateUser 

c. UserName to {{localsim::user:String}} 

d. Group to {{localsim::group:String}} 

e. Policy to {{localsim::policy:String}} 

f. Password to {{localsim::password:String}} 

g. (Optional) DataEntryLostFocusWritesValue to True (This will allow the 

user to click away from the data entry field without losing the value. This 

setting is recommended for local variables only and not live values, 

especially not connected to equipment that may be damaged if an 

incomplete value is written by mistake.) 

7) Add a GridWorX Viewer control. 

8) Configure the GridWorX Viewer. 

9) Select the Grid object. 

10) Set the data tag to cfg:entities/readall<SEC,SecUser> (In the tag browser, this 

tag can be found at Diagnostic > Configuration > Entities > Security > 

SecUser – All.) 

11) Close the GridWorX Viewer configuration. 

12) Save the display. 

13) For best results, confirm that your currently logged-in user has the proper 

permission to create users with this command: 

a. Open Workbench. 

b. Expand Security. 

c. Expand Users and open the desired user or expand Groups and open a 

group that the desired user is a member of. 

d. Find the Application Actions section,  

e. Ensure that these items are enabled (they must be enabled directly on the 

user or on at least one of the groups the user is a member of)  

i. Workbench > Security > Edit Items  

ii. Commands > Configure Security 

iii. (Optional) Workbench > Security > Browse Items (allows viewing 

users in the GridWorX Viewer, but does not affect creating users) 

f. Apply any changes. 

g. Log in as the desired user. 

14) Return to GraphWorX64 and go into runtime. 

15) The GridWorX Viewer should populate with the current users in your security 

configuration. 

16) Enter values into the process points. Group and Policy must match existing group 

and policy names in your security configuration. Here are some example values: 
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a. Username: Test 

b. Group: GroupA 

c. Policy: Leave blank to use the default security policy. 

d. Password: Ensure the password is consistent with the policy's password 

complexity rules. 

17) Select Create. 

18) Refresh the GridWorX Viewer. If the user was created successfully, it should now 

show in the list of users. You should also be able to see the user in Workbench, 

after refreshing the list. 

The user executing the Configure Security command must have edit permission for the 

security configuration (configured on a user or group under Application Actions > 

Workbench > Security) and permission to execute the command, itself (configured via 

Application Actions > Commands > ConfigureSecurity).  

For Further Reference 

• Help: Security in Runtime 

AnalytiX 

AnalytiX-BI 

Performance Enhancements 

(Reference ID: 77788) 

There have been a number of performance enhancements in the AnalytiX-BI server. The 

performance has been improved in multiple areas and should be better overall, but 

these particular areas are worth noting: 

• The Insert action now performs faster on very large datasets (on the order of a 

million rows). (Reference ID: 51162) 

• Read and write transactions can now happen at the same time (previously all read 

queries were locked while a write was happening). (Reference ID: 76412) 

Parameterized Views 

(Reference ID: 82351) 

Reusable queries have been a frequently requested feature for AnalytiX-BI. Now, users 

can achieve this functionality by configuring a view with parameters. Other queries can 

call the view and pass values to those parameters. 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/GWX/Security_in_Runtime.htm
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For example, the user 

could create a view 

named, "MyView", and 

configure it as follows: 

SELECT * FROM 

Orders WHERE CustomerID 

= @CustID AND OrderDate 

> @Date 

 

This includes two 

parameters, @CustID and 

@Date. The parameters 

can be configured in the 

new Parameters section of 

the Data View object in 

Workbench.  

These parameters can be 

supplied when MyView is 

used in another query, such as: 

SELECT OrderID FROM MyView(@CustID = 'ALFKI', @Date = '1996-01-01') 

 

Named parameters can be specified in any order inside the parentheses. The names are 

optional, but when they are omitted, the parameters must occur in the same order in 

which they were configured: 

SELECT OrderID FROM MyView('ALFKI','1996-01-01') 

 

For Further Reference 

• Help: Data Views 
 

New Refresh Type: "Update Existing and Insert New Data" 

(Reference ID: 84278) 

Previously, when adding new data to a BI table, users had to choose between only 

inserting new data or discarding all of the previous table contents and replacing it 

entirely with the new data. 

Under the refresh tab for a table there is now a new Refresh Type called Update 

existing and insert new data. As described in the name, when this refresh type is 

selected any rows that exist will be updated, and rows that do not exist will be inserted. 

(The table's primary key is used to determine if rows exist or are new.) 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AnalytiX_BI_Server/Data_Views.htm
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This new refresh type allows users update existing rows without losing any of the 

previous table contents. 

For Further Reference 

• Help: Data tables 

Expanded Query Functionality 

(Reference ID: 77790) 

Numerous improvements have been made to the query functionality of the AnalytiX-BI 

Server, including: 

• Expressions are now available in all parts of the query, not just in the SELECT list, 

and no longer need to be surrounded by single quotes. Examples:  

SELECT * FROM Categories WHERE CategoryID + 1 > 4 

SELECT * FROM Categories ORDER BY CategoryID * 2 

SELECT AVG(UnitPrice) FROM Products GROUP BY CategoryID - 3 

HAVING AVG(UnitPrice) + 1 > 10.0 

• Expressions can contain aggregate columns. Example: 

SELECT SUM(UnitPrice) / COUNT(UnitPrice) AS [avg] FROM Products 

• Support for LEFT and RIGHT OUTER JOIN. 

• Support for GROUP BY. Previously when using aggregates, any non-aggregated 

columns were grouped, but using an explicit GROUP BY clause allows the user to 

group by a column that is not part of the output. Example: 

SELECT AVG(UnitPrice) FROM Products GROUP BY CategoryID 

• ORDER BY supports OFFSET and FETCH. Example: 

SELECT * FROM Products ORDER BY ProductName OFFSET 10 FETCH 10 

• Support for UNION and UNION ALL. UNION removes duplicate rows, while 

UNION ALL simply unions the results, leaving duplicates (so UNION ALL should 

be used whenever possible for better performance). Examples: 

SELECT CategoryID FROM Categories UNION SELECT ProductID FROM 

Products 

SELECT CategoryID FROM Categories UNION ALL SELECT ProductID FROM 

Products 

• Support for subqueries in the FROM and WHERE clauses. Examples: 

SELECT CategoryID FROM (SELECT CategoryID FROM Categories WHERE 

CategoryID > 3) AS C 

SELECT CompanyName  FROM Customers  WHERE CustomerID IN (SELECT 

CustomerID FROM Orders WHERE OrderDate > '1/3/95') 

SELECT CustomerID  FROM Customers AS c WHERE NOT EXISTS (SELECT * 

FROM Orders  WHERE c.CustomerID = Orders.CustomerID) 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/Apps/WBDT/AnalytiX_BI_Server/Data_Tables.htm
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• Support for CASE WHEN. Both simple case and searched case are supported. 

Examples: 

SELECT CASE ProductID WHEN 10 THEN 'Product 10' WHEN 20 THEN 

'Product 20' END FROM Products  

SELECT CASE WHEN UnitPrice > 20 THEN 20 WHEN UnitPrice < 10 THEN 

10 ELSE UnitPrice END FROM Products --with default 

• Support for IS NULL and IS NOT NULL operators. 

• Support for BETWEEN and NOT BETWEEN operators. 

• Aliases are now always optional in the SELECT clause. 

• Collation support has been added. Example: 

SELECT * FROM Categories WHERE Description COLLATE en-us_ci = 

'Cheeses' 

• It is possible to define and use table aliases. The AS for defining the alias is 

mandatory. Example: 

SELECT p.ProductName, c.CategoryName FROM Categories AS c INNER JOIN 

Products AS p ON c.CategoryID = p.CategoryID ORDER BY p.ProductName 

• All comparison operators are now allowed in a join predicate. Example:  

SELECT p.ProductID, c.CategoryID, c.CategoryName, p.ProductName 

FROM Categories AS c INNER JOIN Products AS p ON p.ProductID != 

c.CategoryID ORDER BY p.ProductID, c.CategoryID 

• WHERE predicates can now compare columns to columns instead of being 

limited to comparing columns and constants. Example:  

SELECT CategoryID, ProductID FROM Products WHERE CategoryID = 

ProductID 

 

• Unqualified columns are allowed if a FROM clause is used. Previously columns 

always had to include the table name. Also, can use * in the SELECT clause 

without a table name. 

• The COUNT aggregate can now be used with *. Note that this counts all rows, 

including NULLs, whereas COUNT when used with a specific column name does 

not include NULLs. Example: 

SELECT COUNT(*) FROM table 

 

Note, due to these enhancements, there are a few queries that used to work in older 

versions that may need to be updated before they work in version 10.97.1. 

Because the WHERE predicate now allows combining columns and columns, rather than 

being limited to columns and constants, users may need to be more careful with 

comparing columns and constants of different types. For example, take this query: 

SELECT * FROM table WHERE SITE_NUM = 6002 
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If SITE_NUM is a column of type String and contains some empty string values (not 

NULLs), the query will fail when encountering those empty strings. This happens 

because the new AnalytiX-BI query parser is implicitly converting these different data 

types into the same type, and Int32 has a higher precedence than String, so BI attempts 

to cast SITE_NUM to Int32. This casting fails for an empty string. 

This worked in previous versions because the constant was always on the right and the 

column always on the left, so the constant was always converted to the type of the 

column, regardless of type precedence. 

In the current version, the best way to resolve this is to explicitly convert the constant to 

the same type as the column. With this specific example, you can specify the 6002 value 

as a literal string: 

SELECT * FROM table WHERE SITE_NUM = '6002' 

If this type conversion problem occurs in the current query parser, a type conversion 

error will be reported. This should make it clear to the user that they must consider the 

types involved.  

That the precedence of types for these sorts of conversions is noted in the help file here: 

AnalytiX BI SQL Language 

A second change is that aliases are no longer usable in the WHERE clause. This was 

necessary to support expressions in WHERE. That means that a query like this used to 

work in the old AnalytiX-BI query parser, but will not work in version 10.97.1: 

SELECT '{{Categories.CategoryID}} + 1' AS expr FROM Categories WHERE expr > 3 

 

To achieve the same result in the new BI query parser, either repeat the expression in 

the WHERE clause or use a subquery, as in these examples: 

SELECT CategoryID + 1 AS c FROM Categories WHERE CategoryID + 1 > 3 

 

SELECT * FROM (SELECT CategoryID + 1 AS c FROM Categories) AS t WHERE c > 3 

 

In both cases, the new functionality works more consistently with SQL Server queries 

than previous instances of the AnalytiX-BI server. 

For Further Reference 

• Help: AnalytiX BI SQL Language 
 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AnalytiX_BI_Server/AnalytiX-BI_Server_SQL_Queries.htm
https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AnalytiX_BI_Server/AnalytiX-BI_Server_SQL_Queries.htm
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BridgeWorX64 

Transactions 

Acknowledgement Support for FDDWorX, Hyper Alarming, and OPC UA  

See Acknowledgement Support for FDDWorX, Hyper Alarming, and OPC UA. 

CFSWorX 

General 

Schedule View in CFSWorX Dashboard 

(Reference ID: 83281) 

The CFSWorX Dashboard now contains a page for displaying worker schedules. 

 

For Further Reference 

• Help: CFSWorX AnalytiX Dashboard Deployment 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/CFSWorX_AnalytiX_Dashboard_Deployment.htm
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Workflow and Alerts 

Microsoft Azure Communications Services SMS 

(Reference ID: 80233) 

CFSWorX alerts can now be sent out via Microsoft Azure Communications Services 

(ACS). For this release, only SMS is supported. We plan to add voice, chat, and incoming 

SMS (for acknowledgements) in later versions. 

To leverage ACS, users must have an Azure account with an active subscription.  

Follow these steps to configure ACS: 

 

1) Choose an active Azure Communication Services resource or create a new one (see 

Create Azure Communication Resource). 

2) Note the connection string of the Communication Services resource. It will be used 

later to configure the ACS Configuration object in Workbench. 

3) Provision a phone number from Azure (see Provision your ACS phone number). 

Choose a number with outgoing SMS capabilities. Note this phone number for 

later use in Workbench. 

4) Open Workbench. 

5) Select Alarms and Notifications > AlertWorX > ACS Configurations.  

6) Use the ribbon or context menu to Add ACS Configuration. 

7) Give the configuration a name. 

8) Enable Is Default Configuration. 

9) If desired, add a description. 

10) Go to the Phone Numbers tab. 

11) Add the phone number obtained from Azure portal in step 3. 

12) Go back to the General Settings tab. 

13) For Default Phone Number, select the phone number added previously. 

14) For ACS Connection String, paste in the connection string for your 

Communication Services resource that you noted in step 2. 

15) Apply the changes. 

16) It is recommended to test the configuration at this point using these steps: 

a. Ensure that AlertWorX is running (ICONICS Alert REST service).  

b. Find the Test this configuration section. 

c. Choose a number you'd like to send a test SMS message to and enter that 

number in To Number (format of +15555555555). 

d. Select Test SMS. 

https://docs.microsoft.com/en-us/azure/communication-services/quickstarts/create-communication-resource?tabs=windows&pivots=platform-azp
https://docs.microsoft.com/en-us/azure/communication-services/quickstarts/telephony-sms/get-phone-number?pivots=platform-azp
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17) If the test failed, correct any issues and test again. Make sure to apply any changes. 

18) In your Connected Field Worker template, use the Azure SMS Message activity to 

send an SMS using this configuration. 

For Further Reference 

• Help: Setting up Azure Communication Services (ACS) 

Send Email using Sendinblue 

(Reference ID: 80247) 

CFSWorX emails can now be sent out via the Sendinblue service. 

To configure Sendinblue emails: 

1) Open Workbench. 

2) Select Alarms and Notifications > AlertWorX > Sendinblue Configuration. 

3) Use the ribbon or context menu to Add Sendinblue Configuration. 

4) Give the configuration a name. 

5) Enable Is Default Configuration. 

6) If desired, add a description. 

7) Fill in the API Key supplied by Sendinblue. (For more detailed instructions on 

how to obtain your Sendinblue API Key, see the help files.) 

8) Fill in the default from email address. 

9) Use the Test Email button to confirm emails are able to send. 

10) If the test failed, correct any issues and test again. 

11) Once the configuration is correct, apply the changes. 

12) In your Connected Field Worker template, use the Sendinblue Email activity to 

send an email using this configuration. 

Note, acknowledgement via Sendinblue email is currently not supported due to 

limitations in Sendinblue's API. 

For Further Reference 

• Help: Setting Up Sendinblue 

Acknowledgement Support for FDDWorX, Hyper Alarming, and OPC UA 

(Reference ID: 83696) 

In previous versions, acknowledging alarms sent via CFSWorX workflows or 

BridgeWorX64 transactions was only supported for AlarmWorX64 Server. Now, in 

version 10.97.1, acknowledgement works with FDDWorX faults, Hyper Alarming alarms, 

and third-party OPC UA alarm and event servers. 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AlertWorX/Acs_Configurations.htm
https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AlertWorX/Sendinblue_Configurations.htm
https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/AlertWorX/Sendinblue_Configurations.htm


Major Enhancements - AnalytiX, CFSWorX 

19 

For Further Reference 

• Help: Notification Methods 

Worker Access 

Display Geofences and Replay Worker Location Path in EarthWorX 

(Reference IDs: 78859, 78862) 

EarthWorX Viewers can now display 

geofences and worker path replays. 

These features were first added to 

KPIWorX maps in version 10.96.2. 

The configuration of geofences has 

not changed and can still be found in 

Workbench under MobileHMI > 

Configuration > Augmented 

Reality. The configuration of worker 

location paths has also not changed. 

The steps can be found in the help 

file under AnalytiX Suite > CFSWorX > Setting Up Worker Path Replay.  

To display geofences in an EarthWorX Viewer: 

1) Go to the EarthWorX Configuration tab. 

2) Select Setup Connection > Add New Connection. 

3) For Map Type, choose Geofences. 

4) Give the connection a name, such as GeofencesConnection. 

5) Select OK. 

6) Add a new map layer. 

7) In the Explorer panel, select the new layer. 

8) Expand the dropdown under the Geofences button and choose 

GeofencesConnection. 

9) Optionally, with the map layer still selected, go to the Properties panel, and 

customize the Geofence Palette. 

The steps to display worker path replay are similar: 

1) Go to the EarthWorX Configuration tab. 

2) Select Setup Connection > Add New Connection. 

3) For Map Type, choose Worker Path Replay. 

4) Give the connection a name, such as WorkerPathConnection. 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Notification_Methods.htm
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5) Select OK. 

6) Add a new map layer. 

7) In the Explorer panel, select the new layer. 

8) Expand the dropdown under the Worker Path Replay button and choose 

WorkerPathConnection. 

9) In the dialog that appears, choose your Path History Data Source. 

10) If desired, customize the color palette. 

11) Select OK. 

Geofences and worker path replay map layers are supported for both desktop (WPF) 

and HTML5 displays. 

For Further Reference 

• Help: Setting Up Worker Path Replay 

Worker Location Data from ServiceNow and Maximo 

(Reference ID: 80838, 80837) 

Instead of using MobileHMI device health data, the location of workers can now be 

determined from ServiceNow or Maximo. On the desired field worker source object, 

select the Use CRM Location box to get location from ServiceNow or Maximo. (See help 

files for information on how to enable the field technician location tracking feature in 

the ServiceNow or Maximo apps.) 

Worker location can also be obtained from Dynamics 365. This functionality was added 

in version 10.97. 

For Further Reference 

• Help:  

o Configuring ServiceNow to obtain mobile location updates  

o Configuring Maximo to obtain mobile location updates 

Energy AnalytiX 

Various Ease of Use and Accuracy Enhancements 

Energy AnalytiX has had a lot of various enhancements to help make it easier to use and 

provide more precise data. These enhancements include: 

• Additional equipment class parameter support for Energy AnalytiX fields: 

o Able to parameterize rollover value for consumption tag (Reference ID: 82196) 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Setting_Up_Worker_Path_Replay.htm
https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Configuring_ServiceNow_to_obtain_mobile_location_updates.htm
https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Connected_Field_Worker/Configuring_Maximo_to_obtain_mobile_location_updates.htm
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o Able to configure equipment classes with energy calculations for virtual 

meter types (Reference ID: 82292) 

• Improved rollup calculation expressions for virtual meters (Reference ID: 82726) 

• Additional energy data aggregation in Hyper Historian for hourly, daily, monthly, 

and yearly periods (Reference IDs: 83045, 83046, 83047, 83048) 

o Improved Energy AnalytiX data model in AnalytiX-BI to take advantage of 

these additional aggregations 

• Support for having different storage intervals for each aggregate type (example, 

store hourly aggregate at a different interval than daily) (Reference ID: 82728) 

• Improved accuracy of consumption calculations, especially in the event of few 

samples or communication delays (Reference ID: 82635) 

Data Models and Sample Dashboards Updated to Use New AnalytiX-BI and KPIWorX 

features 

(Reference ID: 82851) 

The Energy AnalytiX data models and sample dashboards have been enhanced to take 

advantage of features added to AnalytiX-BI and KPIWorX in recent versions, including 

the Sankey diagram and enhanced filters. 

ReportWorX64 

General 

Allow Users to Select a Tag as a Parameter Value 

(Reference ID: 81955, 81957) 

Previously, reports that allowed the user to choose a tag or tags to report on had to 

build the tag name themselves in some fashion, such as using parameters of type, 

"Select from a fixed list of values" or "Select from a dynamic list of values" and pull 

values from a database. These parameter choices would echo the tag space but had to 

be manually synchronized. If new tags were added to the system, they also had to be 

added to the fixed list of values or the database that populated the dynamic list. 

To solve this problem, a new parameter type is introduced in version 10.97.1: Select a 

tag. When executing the report, a parameter of this type will present the user with a tag 

browser, browsing the live address space, and allow them to choose a tag name. The 

parameter can then be used as an alias in other data sources, allowing the user who 

generates the report to choose exactly what tags to report on.  

The user can supply a default value for the parameter to provide a starting place in the 

tag address space. This default value can be a folder name. 
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These "select a tag" parameters are supported when downloading values from the Excel 

Add-In and when executing a report from the desktop (WPF) ReportWorX64 Viewer 

control, but the HTML5 platform does not currently support browsing the tag address 

space, so HTML5 ReportWorX64 Viewers must type in the tag name by hand. We plan to 

add support for an HTML5 tag browser and these "select a tag" parameters in a future 

version. 

For Further Reference 

• Help: Parameters 

Preconfigured Parameters 

(Reference ID: 81431) 

There are three new parameter types in ReportWorX64 that can be used to quickly 

create frequently used parameters. These are not true parameter types, but shortcuts to 

preconfigure a parameter with a prefilled list of values. 

When adding a new parameter, select the given parameter type and the rest of the 

parameter dialog will be configured appropriately. Once created, the user can modify 

these parameters as needed, such as removing options that do not apply to their 

specific system. 

• Aggregate name list – HDA aggregates (such as Interpolative and Average). 

• Datetime format list – Date/time string formats (such as "dd/mm/yyyy" or 

"mm/dd/yyyy"). (Useful with the new Parameterized Date Time and Double 

Formats feature.) 

• Double format list – Double string formats (such as "0.0" and "#,###"). (Useful 

with the new Parameterized Date Time and Double Formats feature.) 

• Sort mode list – Ascending or descending. (Useful with the new Configure 

Sorting of Data Sources feature.) 

Note, each of these parameters has a "true" parameter type, such as "Select from a fixed 

list of values". This parameter type will be shown after the user has navigated away from 

the parameter configuration and back. 

For Further Reference 

• Help: Parameters 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/ReportWorX_Express/Parameters.htm
https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/ReportWorX_Express/Parameters.htm
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Local and Server Machine Name Parameters 

(Reference ID: 81952) 

Two new parameter types have been added: Local machine name and Server 

machine name. These parameters will populate in runtime with the local machine and 

FrameWorX server machine names, respectively. 

Note that reports executed by ReportWorX64 Server will have the same local and server 

machine names.  

For Further Reference 

• Help: Parameters 

Predefined Parameters for Every Template 

(Reference ID: 81952) 

Users who create the same set of parameters for every new template can now create 

predefined parameters. These parameters will be automatically added to every Excel 

template created on this machine. 

To create a predefined parameter: 

1) In Excel, go to the ReportWorX64 ribbon. 

2) Select Quick Enable, if necessary. 

3) Open the General Configuration window. (Depending on your resolution, you 

may need to expand to the last section on the ribbon.) 

4) Expand Parameters. 

5) Select Predefined parameters. 

6) Create your parameters as desired. 

7) Save when finished. 

8) Create a new Excel workbook. 

9) Go to the ReportWorX64 ribbon and enable the ReportWorX64 Add-In. 

10) Select Parameters. You should see your predefined parameters here. 

Predefined parameters will only be added to new workbooks. Once predefined 

parameters are added into a workbook they can be modified like ordinary parameters. 

The predefined parameter settings only define their starting values. 

The predefined parameters are stored on the local machine where Excel is running and 

will not carry over to other machines, even when using the same FrameWorX Server. 

Cell parameters cannot be created as predefined parameters. 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/ReportWorX_Express/Parameters.htm
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For Further Reference 

• Help: Parameters 

Find and Replace in Headers 

(Reference ID: 81271) 

Users can now perform a find and replace on data source headers in a ReportWorX64 

Excel template. 

To perform a find and replace: 

1) Open the template in Excel. 

2) Select one or more data sources 

3) Open the context menu or go to the ReportWorX64 ribbon. 

4) Select Edit > Headers. 

5) Expand the Find and replace section at the bottom of the Header configuration 

window. 

The dialog supports simple find and replace actions along with regular expressions. If 

multiple data sources were selected, the user can filter the replace action to a specific 

data source. 

For Further Reference 

• Help: Excel Add-In 

New Series Column Mode for Charts 

(Reference ID: 81646) 

ReportWorX64 charts were introduced in version 10.97. These charts are created on the 

fly by ReportWorX64, rather than native Excel features. Optionally, users could designate 

one data source column as the "series column" (a common use case would be the point 

name column for a historical data source), allowing one data source to add multiple 

series to a single chart or even create multiple charts, one per series. 

The configuration of whether to create one chart or multiple charts when using a series 

column has been improved in 10.97.1. Now there is a Mode in the Use series column 

section. Mode has three possible values: 

• One chart with all series (1 chart) 

• Each series in a separate chart (N charts) 

• One chart with all series, plus each series in a separate chart (N+1 charts) 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/ReportWorX_Express/Parameters.htm
https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/ReportWorX_Express/Excel_Add-In.htm#
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Not only does this enhanced configuration make it easier to understand the result, but 

previously it was not possible to configure each series in a separate chart without also 

having a chart with all series together. (In other words, previously, options 1 and 3 

existed out of the list above, but not option 2.) 

This feature is supported bot with the "Download Data" feature of the Excel Add-In and 

when the report is executed in the ReportWorX64 Server. 

For Further Reference 

• Help: Excel Add-In 

Configure Sorting of Data Sources 

(Reference ID: 82616) 

In previous versions, ReportWorX64 would insert data into the report in whatever order 

was determined by the data source. Now, the user can specify how the data can be 

sorted. The sort order (ascending or descending) can even be parameterized, giving 

users the opportunity to choose the sort order when executing the report. 

Here is an example of how to add a data source and customize the sorting, including 

using a parameter: 

1) In Excel, add a data source to the sample Data Connectivity > Databases > SQL 

Server > Northwind > Data Sources > Categories table. 

2) Select the data source, then use the context menu or ReportWorX64 ribbon to 

select Edit > Data Source. 

3) Go to the Sort Header tab. 

4) Add the CategoryName header to the sorting list. 

5) Change its Sort Mode to Descending. 

6) Save and close the dialog. 

7) From the ReportWorX64 ribbon, select Download Data. Note that the data is 

now sorted by category name in descending order. 

8) Select Clear Data. 

9) Edit the data source again. 

10) Go to the Global Parameters tab. 

11) Add a new parameter. 

12) Set the Display name to SortOrder. 

13) For Parameter type, choose Sort mode list. 

14) Note the Name of the parameter. If this is your first parameter, it will be param0. 

15) Go to the Sort Header tab. 

16) Enable the Use parameter box for the CategoryName header. 

17) For Sort Mode, choose the parameter you just added. 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/ReportWorX_Express/Excel_Add-In.htm#
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18) Save and close the dialog. 

19) Select Download Data. 

20) When prompted, choose your desired sort order. 

21) Note that the data is ordered by your chosen sort order. You can Clear Data and 

Download Data again and choose the other sort order. 

To sort by more than one column, add multiple columns to the sorting list. The up and 

down buttons can be used to reorder the headers and change the sorting priority. 

Sorting can also be quickly configured by selecting a particular column's cell, then using 

the Edit > Order By option in the ReportWorX64 ribbon or context menu. That column 

will be added to the bottom of the sort list for the data source using ascending order. 

(To change the sort priority or sort order, use Edit > Data Source as described above.) 

The Remove > Remove order by option can be used to quickly remove a column from 

the sorting list. 

To give users the option of not sorting by a particular column, use a parameter, and 

include a "NoSort" choice in the parameter's list. Choosing this option will cause 

ReportWorX64 to skip that column when determining the sorting. 

For Further Reference 

• Help: Chart Support for ReportWorX64 Add-In 

Parameterized Date Time and Double Formats 

(Reference ID: 81415) 

The format of date time and double values in a data source can now be parameterized, 

allowing the user executing the report to choose their desired formats. 

To parameterize the date time or double formats: 

1) In Excel, select your data source. 

2) Use the context menu or ReportWorX64 ribbon to select Edit > Data Source. 

3) Go to the Global Parameters tab. 

4) Add a new parameter. 

5) Set the Display name to DateTimeFormat. 

6) For Parameter type, choose Datetime format list. 

7) Note the Name of the parameter. If this is your first parameter, it will be param0. 

8) Add another new parameter. 

9) Set the Display name to DoubleFormat. 

10) For Parameter type, choose Double format list. 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/ReportWorX_Express/Excel_Add-In.htm%23Chart_Support_for_ReportWorX64_Add-in
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11) Note the Name of the parameter. If this is your second parameter, it will be 

param1. 

12) Go to the Configuration tab. 

13) For Date Time Format enable Use Parameter and choose DateTimeFormat. (If 

you do not see your parameter in the dropdown list immediately, select the 

refresh button.) 

14) For Double Format enable Use Parameter and choose DoubleFormat. (If you 

do not see your parameter in the dropdown list immediately, select the refresh 

button.) 

15) Save and close the dialog. 

16) In the ReportWorX64 ribbon, select Download Data.  

17) When prompted choose your desired double format and datetime format. 

18) The data will populate using your desired formats. 

For Further Reference 

• Help: Excel Add-In 

ReportWorX 365 

Removing Support for ReportWorX 365 

(Reference ID: 85776) 

ReportWorX 365 is an application available in the Office Store that would allow users to 

use a limited set of ReportWorX64 functionality. The ReportWorX 365 app is not 

supported for use with ICONICS Suite servers of version 10.97.1 or later. It will remain in 

the Office Store but will not be compatible with this version of ICONICS Suite. 

Users are encouraged to switch to ReportWorX64 Express or full ReportWorX64, which 

have more functionality than the ReportWorX 365 app. ReportWorX64 Express is 

included at no extra charge in GENESIS64 and most ICONICS Suite packages.  

For questions about this removal, please contact your local ICONICS representative or 

distributor. 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/ReportWorX_Express/Excel_Add-In.htm#


Major Enhancements - Data Connectivity, BACnet Connector 

28 

Data Connectivity 

BACnet Connector 

Technical Preview: BACnet With SC Point Manager 

(Reference IDs: 69019, 84422) 

This version contains a preview of an all new BACnet Point Manager. The new BACnet 

with SC Point Manager is designed for ASHRAE 135-2020 (BACnet Protocol Revision 

22) and includes support for the BACnet Secure Connect (BACnet/SC) addendum to the 

BACnet protocol.  

In addition to this enhanced security, BACnet with SC comes with improved support for 

BACnet alarms, improved network discovery (with better filtering), and multi-channel 

support (allowing BACnet device ID isolation between different networks). 

Along with the improved BACnet with SC Point Manager, the BACnet with SC 

Workbench Provider has been redesigned to work with the latest BACnet standards, 

including support for many new object types.  

The Data Explorer has also been improved to work with the new BACnet with SC Point 

Manager and take advantage of the new features. Currently, the Schedule Control does 

not have support for BACnet SC. We plan to add this support in future versions.  

Since the new BACnet with SC Point Manager is a technical preview, the BACnet Classic 

Point Manager is still included in this version and is the default BACnet Connector. 

There is currently no upgrade path from a BACnet Classic configuration to a BACnet 

with SC configuration, but we plan to have one in future versions.  

The Project Document feature of Workbench, which allows users to generate reports 

about their configuration, has been enhanced to work with either BACnet point 

manager. 

To try out the BACnet with SC Point Manager: 

1) Open Workbench. 

2) Select your project in Project Explorer. 

3) From the context menu or the Home ribbon, select Configure Application(s) 

Settings. 

4) Uncheck BACnet Classic. 
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5) Check BACnet with SC and select the desired SQL Server and Catalog. (This can 

be the same database where the BACnet Classic configuration is located or a 

different database.) 

6) If there is not already a configuration in the desired database: 

a. Select the  Create or overwrite the database associated with this 

application button for BACnet with SC. 

b. If you are sure there is no existing BACnet with SC configuration or you're 

okay with overwriting it, select OK to the warning message. (This will not 

overwrite the BACnet Classic configuration.) 

c. Wait for the configuration to be created in the database. 

7) Apply the changes. 

8) Confirm that the Notes for BACnet with SC say Configuration Active. 

9) In Project Explorer under Data Connectivity, you should now see the BACnet 

with SC provider. 

To switch back to BACnet Classic, follow the steps again except check BACnet Classic 

and uncheck BACnet with SC. Advanced users can enable both applications at the same 

time, but note that they share the same port, so only one point manager can run at a 

time. One set or the other of BACnet services must be disabled from the Windows 

Services control panel. (The Configure Application(s) Settings dialog takes care of this 

when only one application is enabled.) 

There are some notable differences in the behavior of BACnet with SC and BACnet 

Classic that users may want to be aware of. ICONICS plans to update many of these 

differences in a future version when the BACnet with SC Connector is officially released. 

• Trends – BACnet with SC does not currently support BACnet trends. 

• Schedule Control support – The schedule control's BACnet Schedule View and 

BACnet Calendar View do not currently support BACnet with SC.  

• Backup device support – Devices cannot currently be backed up or restored 

using BACnet with SC. 

• BBMD support – BBMDs are not currently supported in BACnet with SC.  

• Device templates – BACnet with SC currently only has one default device 

template. 
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• Device status checking – In BACnet Classic, Workbench automatically detects a 

device's status and reflects this in the device's icon in the Workbench tree. This is 

done by regularly polling each device's systemStatus point. With BACnet with SC, 

Workbench only polls systemStatus to updates a device's status icon when the 

device is refreshed. This means the Workbench icons do not update 

automatically, but it is a more efficient use of resources. A refresh action can be 

manually triggered from each individual device or from the parent level of all 

devices. 

• List modification – BACnet with SC does not currently support the 

"ModifyListProperty" method, meaning it cannot add or remove elements in a 

list. 

• Time/date and priority array format – BACnet with SC exposes time/date data 

types and priority arrays as JSON objects, rather than datetime and arrays, 

respectively. 

For Further Reference 

• Help: Overview of BACnet/SC 

EtherNet/IP Connector 

EtherNet/IP Connector Deprecated 

(Reference ID: 85331) 

The EtherNet/IP Connector has been deprecated in this version. It will not be visible by 

default after installing 10.97.1 or upgrading to it from a previous version. Users who 

were utilizing the EtherNet/IP Connector in a previous version can restore it by following 

a series of steps outlined in the help files. 

There are no current plans to replace the EtherNet/IP Connector in a future version of 

ICONICS Suite, and we anticipate at some point it will no longer be included, even in a 

hidden fashion. We recommend that users interested in EtherNet/IP connectivity should 

ask their distributor or sales representative about the Takebishi DeviceXPlorer. 

For Further Reference 

• Help: EtherNet/IP Connector Deprecation 

Mitsubishi Electric Factory Automation (FA) Connector  

Support for Additional PLC and GOT Series 

The Mitsubishi Electric FA Connector has added support for these PLC series: 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/BACnet_SC/Overview_of_BACnet_SC.htm
https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/EtherNet_IP/EtherNet_IP_Deprecation.htm
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• iQ-L (LHCPU) 

• Q (QCPU, QSCPU) 

• L (LCPU) 

• FX (FXCPU) 

And these GOT series: 

• GOT2000 (GT27, GT25) 

• SoftGOT2000 

For Further Reference 

• Help: MELSEC System Configuration 

OPC UA Connectivity 

Read Support for Structured Variables 

(Reference ID: 80887) 

In 10.97.1, FrameWorX can now support reading OPC UA structured variables. 

Previously, structured variables did not come through to FrameWorX, aside from a few 

specific exceptions. 

For client applications that cannot yet work with the whole structure, it is possible to use 

the member() modifier to access individual members. 

For example, assume we have a UA structured variable named 

"ua:MyServer\\:Server.:ServerStatus". Its members can be accessed with the "member" 

modifier like this: 

• member(ua:MyServer\\:Server.:ServerStatus).CurrentTime 

• member(ua:MyServer\\:Server.:ServerStatus).BuildInfo 

If BuildInfo is another structure, its members can be accessed like this: 

• member(ua:MyServer\\:Server.:ServerStatus).BuildInfo.SoftwareVersion 

• member(ua:MyServer\\:Server.:ServerStatus).BuildInfo.ManufacturerName 

Note, writing to OPC UA structured variables is not currently supported. 

Systems with a GENESIS64 Basic SCADA license must use the member() function and 

map individual structured variable leaves to the Real-time Data tab of an AssetWorX 

equipment property. Using the example above, a Basic SCADA user could access the 

current time, software version, and manufacturer name by creating three AssetWorX 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/MELCO/System_Configuration.htm%23MELSEC_System_Configuration
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equipment properties, going to the Real-time Data tab of each one, selecting a Source 

type of Dynamic tag, then setting each equipment property's Real-time data tag to 

one of these: 

• member(ua:MyServer\\:Server.:ServerStatus).CurrentTime 

• member(ua:MyServer\\:Server.:ServerStatus).BuildInfo.SoftwareVersion 

• member(ua:MyServer\\:Server.:ServerStatus).BuildInfo.ManufacturerName 

Mapping AssetWorX properties to a complex member, such as 

member(ua:MyServer\\:Server.:ServerStatus).BuildInfo, is not currently supported. Each 

simple child value must have its own equipment property if it is to be read in a Basic 

SCADA system. 

For Further Reference 

• Help: OPC and FrameWorX 

Takebishi DeviceXPlorer OPC Server 

Version 6.4.0 

The Takebishi DeviceXPlorer OPC Server for ICONICS included on the ICONICS Suite 

installation media has been updated to version 6.4.0.  

Version 6.4.0 contains some improvements and fixes. See the included readme file in the 

OPC_Servers\dxpserver folder for details on what has changed since the previous 

version. 

To install DeviceXPlorer 6.4.0, run setup.exe from the OPC_Servers\dxpserver folder 

and follow the installation prompts. If a previous version of DeviceXPlorer is already 

installed, it must be uninstalled before this version can be applied. See this page for 

instructions on how to preserve the previous version's configuration. 

GENESIS64 

Alarms and Notifications 

AlertWorX 

See Microsoft Azure Communications Services SMS and Send Email using Sendinblue. 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Intro/OPC_and_FrameWorX.htm
https://www.faweb.net/en/faq/detail/154
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Hyper Alarm Logger 

New Module: Hyper Alarm Logger 

(Reference ID: 81606) 

In version 10.97, ICONICS introduced the Hyper Alarm Server. Now, in version 10.97.1, 

we also introduce its companion, the Hyper Alarm Logger. 

The Hyper Alarm Logger is a new alarm logger that is natively integrated with the latest 

ICONICS technology, such as Platform Services and AssetWorX. It provides reliable data 

logging of alarm events from any alarm source, including AlarmWorX64 Server, BACnet 

alarms, third party UA alarm servers, and of course, Hyper Alarm Server.  

Events are stored in SQLite databases, providing easy access and an open data structure, 

and can be viewed with the AlarmWorX64 Viewer's. Older data can be archived for 

optimal use of hard drive space and cold storge.  

The Hyper Alarm Logger can be run in a redundant pair, and store-and-forward 

functionality can ensure data is not lost in the event that communication to the data 

storage is temporarily interrupted. 

The AlarmWorX64 Logger is still available for the sake of backwards compatibility, but 

for new systems users are encouraged to use the new Hyper Alarm Logger for forward 

compatibility, best performance, and the most extensive functionality. 

The Hyper Alarm Logger uses the AlarmWorX64 Logger license, so it can be used with 

any product that includes AlarmWorX64 Logger. Licensing is node-based, so the Hyper 

Alarm Logger and AlarmWorX64 Logger can both run on the same machine at the same 

time even with only one available AlarmWorX64 Logger license. 

For Further Reference 

• Application Note: Hyper Alarm Logger – Quick Start 

• Help: About Hyper Alarm Logger 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Hyper_Alarm_Logger/About_Hyper_Alarm_Logger.htm
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Controls 

Data Diagram 

Support for Query Interface 

(Reference ID: 82668) 

The Data Diagram control now supports the Query Interface. The Query Interface 

provides enhanced performance and filtering for datasets. To use the Query Interface 

with the Data Diagram, configure the control, go to the General page, and set the Type 

to Query.  

The Data Diagram's Query Interface support can be used in both desktop (WPF) and 

HTML5 formats. 

EarthWorX 

Support for Geofences and Replay of Worker Location Path 

See Display Geofences and Replay Worker Location Path in EarthWorX. 

Query Interface 

Technical Preview: Display Historical Data in Table, Data Diagram, Sankey Diagram via 

Query Interface 

See Technical Preview: Display Historical Data in Table, Data Diagram, Sankey Diagram 

via Query Interface. 

Data Diagram Supports Query Interface 

See Support for Query Interface. 

GENESIS64 Basic SCADA Suite Option 

Updates to GENESIS64 Basic SCADA 

Most of the improvements mentioned in this document also apply to GENESIS64 Basic 

SCADA, except where GENESIS64 Basic SCADA did not previously include the module 

being improved, or otherwise noted in the description of the feature. 

In addition to those updates, these enhancements and changes are specific to 

GENESIS64 Basic SCADA systems. 
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• AssetWorX "Advanced Features" are no longer restricted from Basic SCADA 

licenses. No AssetWorX features are hidden from Workbench, starting in version 

10.97.1, and the Bulk Asset Configurator is now included. (Note, AssetWorX 

Viewer still requires an add-on license.) (Reference IDs: 83759, 83762) 

• The new Hyper Alarm Logger and BACnet with SC modules can be used with 

GENESIS64 Basic SCADA licenses at no additional cost. 

• These items are now included in a default Basic SCADA installation (they were 

usable before now, but users needed to choose them in a custom installation): 

o Hyper Alarm Server (Reference ID: 83876) 

o GraphWorX64 symbol library (Reference ID: 84414) 

o GraphWorX64 starter displays  (Reference ID: 84034) 

• The Sankey diagram, which was new in version 10.97, is hidden unless DATASETS-

VIEW-CLIENT add-on license is present. (Reference ID: 84415) 

 

For Further Reference 

• Application Note: GENESIS64 Basic SCADA – Quick Start 

• Help: GENESIS64 Basic SCADA 

GraphWorX64 

Execute Commands on GraphWorX64 Events 

(Reference IDs: 67252, 83890) 

We've added significant flexibility to commands in version 10.97.1 by adding events to 

GraphWorX64 that can be used to trigger commands. Many controls already had the 

ability to associate commands with events for that control, but now commands can be 

attached to GraphWorX64 overall events, dynamics, and GraphWorX64 Viewers. 

To configure GraphWorX64 event commands: 

1. Ensure you are in advanced mode (View ribbon > Application Mode > 

Advanced Mode). 

2. Select the object or dynamic with the event in question, such as: 

a. The ThisDisplay object (i.e. deselect all objects). 

b. A layer. 

c. A dynamic on an object. 

d. A GraphWorX64 Viewer. 

3. On the Properties panel (for This Display, layers, or GraphWorX64 viewers) or 

Dynamics panel (for dynamics), find the Runtime – Event Commands section. 

4. Edit the EventCommands property.  

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/BasicSCADA/GENESIS64_Basic_SCADA.htm
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5. In the dialog that opens, choose your event from the dropdown and add 

commands to it.  

The configured commands will now be executed automatically when the event occurs. 

Multiple commands configured for the same event will be executed in parallel. To 

ensure a particular order, use a batch command.  

Many events have associated context variables. For example, commands attached to the 

DataEntryValueEntered event can use "@@valueentered.value" to get the value that was 

written. These context variables are available in the expression editor within a command. 

Open the expression editor, select Variables, then go to the Context Variables tab. 

It is possible to disable the commands on an object without completely removing them. 

Simply set EnableEventCommands to false. Set it back to true when you are ready for 

your commands to work again. 

These commands will execute in both the desktop (WPF) and HTML5 platforms. 

For Further Reference 

• Help: Event Commands 

Referenced SVG Images 

(Reference IDs: 81986, 82190) 

Users now have a choice when incorporating SVG images into their GraphWorX64 

displays. Previously, SVGs had to be imported, and the import process converted them 

into GraphWorX64 native shapes. This functionality is still available, but now users also 

have the option of adding SVGs as reference images. 

A referenced SVG is represented in GraphWorX64 as a single object with no children. 

When the GraphWorX64 display loads it reads the referenced SVG file and loads it on 

demand in the display. The shapes are not stored as part of the display. Because of this, 

reference SVGs cannot be modified inside GraphWorX64. Dynamics can be added to the 

entire SVG, but not to individual elements or shapes in the SVG. 

The chief benefit to referenced SVGs is performance. They are faster to render, especially 

in HTML5 displays, when the same SVG is rendered many times in a display, or when the 

SVG contains a lot of objects. 

There are several different ways to add a referenced SVG image: 

• Use the Insert Referenced Image button in the GraphWorX64 ribbon and 

choose an SVG or SVGZ file.  

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Event_Commands.htm
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• Drag an SVG or SVGZ file from File Explorer into the GraphWorX64 display while 

holding the Alt key. (Dragging without the Alt key will do a traditional SVG 

import.) 

• Use the right mouse button to drag an SVG or SVGZ file from File Explorer into 

the GraphWorX64 display. Choose Insert as Referenced from the context menu 

when dropping. 

If you insert a referenced SVG image and decide it should have been imported instead, 

open the context menu on the referenced SVG object and choose Convert to Shapes. 

This will change the reference image into a collection of shapes, giving the same result 

as if the SVG image were imported in the first place. 

These referenced images are supported in both the desktop (WPF) and HTML5 

platforms. 

For Further Reference 

• Help: Referenced SVGs 

WPF Embedded Web Browser is Now Edge-Based 

(Reference ID: 80656) 

In desktop GraphWorX64 or WPF WebHMI, the previous embedded web browser was 

based on Internet Explorer (IE), which limited the pages that could be loaded or caused 

strange behavior if the pages were not coded to be IE-compatible. 

Now in WPF clients, the ICONICS web browser control uses Microsoft's Chromium-

based Edge browser for rendering. Pages loaded in the embedded web browser should 

now render the same as in Edge. 

Displays will be upgraded to use the new web browser automatically, but users who 

need the legacy web control based on IE can set the UseLegacyWebBrowser property 

to true on the web browser control to switch back. 

For Further Reference 

• Help: Web Browser 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/GWX/Referenced_SVGs.htm
https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/GWX/Web_Browser.htm
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Hyper Historian 

General 

Technical Preview: Display Historical Data in Table, Data Diagram, Sankey Diagram via 

Query Interface 

(Reference ID: 75247, 84800) 

As a technical preview, Hyper Historian data can now be easily displayed in controls that 

support the Query Interface, including Table, Data Diagram, and Sankey Diagram 

controls. 

 

In previous versions, displaying Hyper Historian data in a tabular format often required 

the use of the Hyper Historian SQL Query Engine. Now this data can easily be displayed 

in the Table and other controls without having to write any queries or use GridWorX 

Server. 

The Hyper Historian query interface supports the Tags table, containing information 

about the tags being logged, and the Data table, containing logged historical data and 

annotations. 

To display Hyper Historian data in the Table control using the Query Interface, follow 

the steps below. (Note, these steps assume you are using the sample Hyper Historian 

configuration.) 

1. Make sure the ICONICS Hyper Historian Query Interface service is running. 

2. Open GraphWorX64 in configuration mode. 

3. Add a Table control. 

4. Configure the table control. 

5. On the Data Source page, make sure the Type is set to Query. 

6. For Data Source, choose the Hyper Historian Query Interface by using one of 

these methods: 

a. Select the square on the right and choose hh:.Query. 

OR 
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b. Browse for tags and select Historical Data > Hyper Historian Query 

Interface > .Query. 

7. For Table, select Historical Data. 

8. Under Parameters, for Resampling Interval, select 1 minute. 

9. Go to the Fields page. 

10. In the Fields section, select the  refresh button to retrieve the fields in this 

table. By default, you will only get a Timestamp field. 

11. Use the add  button then select Browse to browse for a new column to add. 

12. Select Signals > Ramp > Value > Interpolative. This will give us the value of the 

Signals > Ramp tag using the Interpolative aggregate. 

13. Use the add button again to add these tags: 

a. Signals > Random > Value > Interpolative 

b. Signals > Sine > Value > Interpolative 

14. Go to the Columns page. 

15. Select the  refresh button to automatically map our selected fields to table 

columns. 

16. Go to the Filters page. 

17. Use the  add button to add a new filter. 

18. Under Expressions, use that  add button to add a new expression. 

19. Configure the expression with these values: 

a. Field: Timestamp 

b. Operator: Is greater than or equal to 

c. Value: Select a good start time for your data, such as an hour ago. 

20. Add a second expression. 

21. Ensue Add is selected for that second expression. 

22. Configure the second expression with these values: 

a. Field: Timestamp 

b. Operator: Is less than or equal to 

c. Value: Select a good end time for your data, such as the current time. 

23. Select OK to apply the changes and close the configuration dialog. 

24. Go into runtime. You should see the interpolated values at once a minute for the 

three tags you selected, starting from the start time. 

Note, both a beginning and end filter are necessary when filtering on the timestamp 

column. 

To see annotations, add a field, browse for your tag, expand it, then expand Annotation. 

You can add the message, time, and username of the annotation as fields. 
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For a more interactive table, a TrendWorX64 Viewer can be used to supply the time 

range to the table. After following the steps above, you can follow these steps to add a 

TrendWorX64 Viewer: 

1. Add a TrendWorX64 Viewer to the display. 

2. Configure the TrendWorX64 Viewer. 

3. Select the Chart object. 

4. On the Chart tab, Enable the Commands on Events section. 

5. Configure the Commands on Events. 

6. Select the Time Range Changed event. 

7. Use the  add button to add a new command. 

8. Choose the Write Value command. 

9. Configure the command with these values: 

a. PointName: @sim64:String.Static("Start").Value 

b. ValueType: String 

c. Value: {{x={{@@chart.starttime}}}} 

10. Add a second Write Value command and configure it with these values: 

a. PointName: @sim64:String.Static("End").Value 

b. ValueType: String 

c. Value: {{x={{@@chart.endtime}}}} 

11. Select OK. 

12. If desired, add more pens to the TrendWorX64 Viewer. These pens are the same 

as those used in the Table control: 

a. hh:\Configuration\Signals:Ramp 

b. hh:\Configuration\Signals:Random 

c. hh:\Configuration\Signals:Sine (usually added by default) 

13. Go to the Range tab and enable Start Frozen. 

14. Close the TrendWorX64 Viewer configuration. 

15. Configure the Table control. 

16. Go to the Filters page. 

17. For the first filter ("greater than"), set Value to 

{{@sim64:String.Static("Start").Value}}.  

18. For the second filter ("less than"), set Value to 

{{@sim64:String.Static("End").Value}}. 

19. Select OK. 

20. Go into runtime. Observe that you can change the range of the TrendWorX64 

Viewer and the Table control will refresh to display the data in the range. 
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Note, the Time Range Data Source field on the General tab of the Table control does 

not apply to Hyper Historian Query Interface data. Time Range Data Source only applies 

to microchart columns. Use the above-described method of setting a start and end 

timestamp filter to synchronize the Table control with another control like the 

TrendWorX64 Viewer. 

IoTWorX & Internet of Things 

Internet of Things 

MQTT Sparkplug Connector 

(Reference ID: 82871) 

Integrated into the Internet of Things Point Manager, the subscriber connections can 

now communicate using the Sparkplug B protocol. 

Sparkplug B provides a standardized format for MQTT messages and standardized topic 

structures. Sparkplug-compliant devices can publish to an MQTT broker, then ICONICS 

clients can subscribe to that MQTT broker and receive the data in a known format. No 

custom decoder needed. 

To communicate using Sparkplug:  

1) Set up an MQTT Broker and configure it appropriately for your desired broker. 

2) Right-click on the Subscriber Connections folder and select Add Sparkplug 

Subscriber Connection. 

3) In the Sparkplug Settings section, choose your MQTT Broker from step 1. 

4) Configure the rest of the subscriber connection settings appropriate for your 

system. 

 

For Further Reference 

• Help: MQTT Sparkplug Connector 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Tools/IoTWorX/MQTT_Sparkplug_Connector.htm
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Easier Configuration for Subscribers of ICONICS and Non-ICONICS Devices 

It's now easier to configure a system with a combination of ICONICS and non-ICONICS 

devices. 

In previous versions, if the user wanted to ingest data from both standard IoTWorX 

devices and third-party gateways, they needed to create two separate IoT Subscriber 

Connection, one with the "Enable compatibility with ICONICS Clients" box selected and 

one without. 

In version 10.97.1, the same Subscriber Connection can be used to ingest custom JSON 

data from third-party devices and from standard IoTWorX devices at the same time. 

Once the Subscriber Connection is created, both types of devices will appear 

automatically in the data browser. The "Enable compatibility with ICONICS Clients" 

option is no longer part of the subscriber configuration. 

For Further Reference 

• Help: Subscriber Connections 

IoTWorX 

IoTWorX Deployment 

Support for Windows Edge Devices using EFLOW 

Windows devices can now be configured as IoTWorX gateways using EFLOW. For 

instructions on how to configure a Windows IoTWorX gateway using EFLOW, see the 

IoTWorX quick start instructions in the help or application notes. 

For Further Reference 

• Application Notes: IoTWorX – Quick Start 

• Help: IoTWorX – Quick Start 

Azure Marketplace Deployment 

As an alternative way to deploy to IoTWorX devices, IoTWorX is now available on Azure 

Marketplace. Users can deploy IoTWorX as Marketplace Modules from the Azure Portal. 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Tools/IoTWorX/Subscriber_Connections.htm
https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Tools/IoTWorX/IoT_Gateway_Suite_Quick_Start.htm
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Simplified Initial Setup 

(Reference ID: 80298) 

The initial setup process of an IoTWorX edge device (also known as a gateway) has been 

simplified. In the past, files needed to be placed on a system before the IoTWorX 

modules could work properly. The IoTWorX installation took care of this in previous 

versions. Now, in version 10.97.1, these files no longer need to be present. 

IoT Edge (and its prerequisites) still need to be installed and provisioned, but this can be 

done with a few simple steps. 

Because of these changes, there is no IoTWorX DVD or ISO file for version 10.97.1. 

Instead, the IoTWorX Tools ZIP file is provided, which includes some instructions and a 

batch file to help in the provisioning process. 

For Further Reference 

• Help: Setting Up the IoTWorX Edge Device 

Hyper Alarming Publishing 

(Reference ID: 81496) 

Version 10.97 introduced alarming support on the edge device via the new Hyper Alarm 

Server, but the alarms could only be viewed locally on the edge device. Now, in version 

10.97.1, alarms can be published by the IoT Publisher and consumed by the IoT 

Subscriber. Subscribed alarms are translated to A/E format and exposed to ICONICS 

alarm clients such as AlarmWorX64 Viewer and AlarmWorX64 Logger. Users can 

acknowledge published alarms. 

To configure which alarms to publish, add or configure a publish list, then use the 

Published Alarms tab. 

For Further Reference 

• Help: Hyper Alarm Server - IoTWorX 

Edge Device Data Connectivity 

Takebishi DeviceGateway OPC UA Server Container 

(Reference ID: 84482) 

The Takebishi DeviceGateway (DWG) OPC UA Server is available on IoTWorX edge 

devices. This is a Takebishi OPC UA Server provided as an IoT Edge Module (in a Docker 

container) and designed to be licensed and deployed with IoTWorX.  

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Tools/IoTWorX/IoT_Gateway_Suite_Quick_Start.htm%23Setting_Up_the_IoT_Device
https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Tools/IoTWorX/Hyper_Alarm_Server.htm
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For Further Reference 

• Help:  About IoTWorX 

MQTT Sparkplug B and OPC UA 

IoTWorX edge devices can take advantage of the new features in these areas: 

• BACnet connectivity (see BACnet Connector) 

• MQTT Sparkplug connectivity (see MQTT Sparkplug Connector) 

• OPC UA (see OPC UA Connectivity) 

Workbench IoT Projects 

Simplified Configuration and New Options 

All dialogs in IoT projects have been simplified for easier configuration, and options 

have been added to clear the cache for each device and restart the containers remotely. 

WebHMI and MobileHMI 

HTML5 WebHMI and MobileHMI Apps for iOS and Android 

Technical Preview: 3D Viewer Support 

(Reference ID: 76408) 

In this version, users can preview 3D viewport support in HTML5 WebHMI and 

MobileHMI displays. This feature will close a significant functionality gap compared with 

WPF WebHMI (which runs only in Internet Explorer) and desktop GraphWorX64. 

The 3D viewport is now available when GraphWorX64 is in Web Browser or Mobile App 

edit mode. Previously the 3D viewport was only available in the Desktop App or UWP 

App modes. 

The preview 3D support must be enabled in ico.anyglass.parsing.config by setting 

<Experimental3DSupport enabled=”true”/>. Without this enabled, the 3D viewport will 

not be rendered in HTML5 displays. 

There are some limitations and differences to the HTML5 3D support from the WPF 

implementation. Most notably, these are not supported: 

• Annotations and embedded GraphWorX64 Viewers in the 3D space 

• Primitives: Tiling, custom tile, mapping, and mapping direction properties 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Com/Tools/IoTWorX/About_the_ICONICS_IoT_Gateway_Suite.htm
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• Camera View: Camera Patrol, Camera Follow 

• Materials: Back material, 2D material, material mapping and mapping directions 

(only solid color materials are supported) 

• Dynamics: Disable dynamic 

Note, in HTML5 displays the 3D viewport will be rendered on top of any other controls 

or elements in the GraphWorX64 display. 

For Further Reference 

• Help: Mobile 3D Viewports 

Export Image of Display 

(Reference ID: 59236) 

The Export Image command can now be used to capture an image of the GraphWorX64 

display running in an HTML5 browser or the MobileHMI app. 

When used in a batch command, following commands can use the @@result[filename] 

context variable to retrieve the location of the saved image file for subsequent 

downloading or display. 

These example steps can be used to create a button to export an image and open the 

file in a browser tab. 

1) Open GraphWorX64. 

2) Optional: At the bottom right of the window, set the mode to Web Browser. 

3) Make sure the display or GraphWorX64 Viewer has a commanding name. 

a. To set the commanding name of the current display: 

i. Select the canvas by deselecting all other objects. 

ii. Go to Properties. 

iii. Set SpecifyRuntimeWindowProperties to True. 

iv. Expand RuntimeWindowProperties. 

v. Set CommandingName to your desired name. For example, gwx. 

b. To set the commanding name of a GraphWorX64 Viewer: 

i. Select the GraphWorX64 Viewer. 

ii. Go to Properties. 

iii. Set CommandingName to your desired name. For example, gwx. 

4) Add a button. 

5) For Command, choose Batch. 

6) Edit the command steps. 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/GWX/Mobile_3D_Viewports.htm
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7) Add an Export Image command. 

8) Edit the command parameters.  

9) Specify a FileName (such as test.png) 

10) Choose CurrentView for Area. 

11) For Target, enter the commanding name of the display or viewer you want to 

capture. For example, gwx. 

12) Select OK when done editing the parameters. 

13) Set the Timeout value to 5000. 

a. The export image action may take longer than the default of 1000 

milliseconds. Depending on the system it may need longer than 5000. 

Adjust this value as needed. 

14) Add an Open URL command. 

15) Edit the command parameters. Select New Window for the TargetType and for 

URL, use this expression: {{x={{@@result[filename]}}}} Select OK when done 

editing the parameters. 

16) Select OK to the batch command configuration. 

17) Optional: Add some other shapes or text to the display. 

18) Save the display into the PubDisplay folder (or another web-accessible folder). 

19) Open the display in an HTML5-compliant browser. (If GraphWorX64 is in Web 

Browser mode, you should be able to use the Open in Web Browser button in 

the top right corner.) 

20) Select the button. An image of the current view should open in a new browser 

tab. 

a. If the new tab doesn't open after five seconds, consider increasing the 

timeout value in step 13. 

For Further Reference 

• Help: Export Image of Display 

Feature Parity Improvements 

HTML5 browsers and the MobileHMI apps for iOS and Android can now use the 

following features and functionality that were previously only available in the desktop 

GraphWorX64 app (WPF) or the Universal Windows Platform (WPF) MobileHMI app.  

General 
Ref ID Description 

83004 
The tab key can now be used to switch between writable fields in grids, such as in the GridWorX Viewer and Table 

control. 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/GWX/Export_Image_of_Display.htm
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AlarmWorX64 Viewer 
Ref ID Description 

64670 
The HTML5 AlarmWorX64 Viewer now supports the AutoFlipInterval advanced property, which allows the flip view to 

automatically cycle through alarms. 

84075 
The DoubleFormat property of the AlarmWorX64 Viewer is now supported. (This property is configured on the 

Advanced tab of the grid object.) 

84078 
The HTML5 AlarmWorX64 Viewer's grid now supports grouping range, both using the Grouping Range tab or the 

"Severity Range" grouping type on the Grouping tab. 

Camera Control 
Ref ID Description 

83638 The HTML5 camera control can now display RSTP video streams. No additional configuration is required. 

Data Diagram 
Ref ID Description 

82077 The HTML5 Data Diagram now supports tooltips. 

GraphWorX64 
Ref ID Description 

59432 HTML5 displays now support the ToolTipDuration display-level property. 

63061 HTML5 displays now support the Foreground and Background properties of popup menu items. 

83843 The Runtime Value feature of smart symbol smart properties now works in HTML5 clients. 

GridWorX 
Ref ID Description 

70563 The HTML5 GridWorX Viewer now supports the Show Cursor option. 

82543 
The HTML5 GridWorX Viewer now respects the "Allow Move Columns" setting. Previously columns were always 

allowed to be reordered regardless of this setting. 

84245 In the HTML5 GridWorX Viewer, the X or Y axis title no longer needs to be surrounded by single quotes to appear. 

Schedule Control 
Ref ID Description 

81970 

81971 

Users can now cut, copy, paste, delete, and drag and drop events. These operations can only be performed on one 

event at a time. Note that only the start cell will be highlighted during a drag operation. 

83664 The HTML5 Schedule Viewer now supports the title and subtitle. 

TrendWorX64 Viewer 
Ref ID Description 

61090 

The HTML5 TrendWorX64 Viewer now supports using the keyboard arrow keys to move the cursor. Note that the 

user must first put focus on the chart by tapping or clicking with the mouse. Holding down the arrow key is not 

supported - this is a limitation of the HTML5 platform. 

66394 The HTML5 TrendWorX64 Viewer can now support cursor widths larger than 10. 

75490 The legend now supports using an image as the background. Note, tiling is not supported. 

82463 The HTML5 TrendWorX64 Viewer can now display the low and high ranges in the legend. 

Workbench 

General 

Small Configuration Improvements 

There have been various small improvements to the configuration across many different 

providers including but not limited to SNMP, IoTWorX, and the alarm subscriptions in 

various areas such as CFSWorX, BridgeWorX64, triggers, and AlertWorX. 
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Notification of System User Password Change 

(Reference ID: 30084) 

All ICONICS services run as a particular Windows user, chosen by the user on 

installation. If the password of this user ever changes without updating the services, the 

system may not run after a reboot. This can lead to a dangerous situation where 

someone unknowingly updates the password and doesn't update the system until 

weeks later, then nothing works and there's no apparent reason. 

A new notification has been added to Workbench to identify this situation. This 

notification appears if the password for this ICONICS services user changes and the 

services have not been updated. The notification advises the user to run the Configure 

System utility, which will make the appropriate changes to update the services with the 

new password. 

A GenEvent message also appears in this situation. This can be used to notify outside of 

Workbench. 

For Further Reference 

• Help: Local User 

Project Reporting 

Additional Reports for Security Configuration 

(Reference ID: 83132) 

The Project Document feature can now generate more reports about the security 

configuration of your project. These reports are now available: 

• Groups privilege – Each group in the security configuration, and the list of 

security permissions it has configured. 

• Users and groups – The security mode, reserved licensing status, and write 

licensing status for each user and group in the security configuration. 

• Users by group – The memberships of users and groups, along with the security 

mode, reserved licensing status, and write licensing status for each user. 

• Users privilege - Each user in the security configuration, and the list of security 

permissions it has configured. 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/Local_User.htm
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To generate one of these reports, go to the Project Explorer, select your project, bring 

up the context menu or go to the Home ribbon, and select Project Document. When 

selecting the reports for the project document, select one or more of the [Security] 

reports. 

For Further Reference 

• Help: Project Document 

https://docs.iconics.com/V10.97.1/GENESIS64/Help/ICONICS_Product_Help.htm#Apps/WBDT/ProjectWorX/Project_Documentation.htm
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Additional Enhancements 

Common & Platform Services 

Data Browser 

Ref ID Description 

81089 

Data browsing can now be secured with ICONICS security. When configuring the permissions for a group or user, the 

Points tab contains a Browse column in addition to the Read and Write columns. Users without browse permission 

will be unable to see the matching tags and folders in the data browser and in search results. 

83540 

83898 

83922 

Network browsing for OPC-UA, FrameWorX servers, GenBroker64 has been disabled by default. This feature required 

insecure system settings which ICONICS does not recommend, and which were disabled by default on many 

operating systems. 

 

Instead of browsing the network for servers, users should explicitly configure the remote servers that will appear in 

the data browser under Network. To configure FrameWorX Network, add them in Workbench under Platform 

Services > FrameWorX > Network Settings > FrameWorX Network. For OPC UA Network, go to Data Connectivity > 

OPCUA > OPC UA Network. For GenBroker64 Network, go to Platform Services > FrameWorX > Server Settings > 

GenBroker64 Settings and add your servers to the desired channel. 

 

Users who were able to use network browsing in the past may reenable network browsing for FrameWorX and 

GenBroker64, but the functionality is not guaranteed to work and ICONICS will not be able to troubleshoot network 

browsing issues (other than to advise that servers be configured manually, as described above). To reenable network 

browsing for FrameWorX, launch Platform Services Configuration from Workbench or the Start menu, go to the Point 

Managers tab, select the Networking point manager, set BrowseOnlyConfiguredServers to false, then restart the 

FrameWorX service. To reenable network browsing for GenBroker64, edit IcoSetup64.ini (located by default in 

C:\ProgramData\ICONICS) and add or modify this INI entry: 

 

[GENBROKER\GenBroker] 

DisableNetEnum=0 

86243 Improved the data browser handling of tags with multiple types (such as DA and AE or DA and HDA). 

FrameWorX 

Ref ID Description 

37761 

Custom point managers can now provide a description to show in the Platform Services Configuration's Point 

Managers tab. See the Extensibility ToolWorX documentation for more details. (Contact your sales representative or 

distributor for information on obtaining Extensibility ToolWorX.) 

52632 

Users who prefer to their alarm servers to seamlessly fail over without any notice or warning to the user can disable 

the "Alarm subscription created successfully" and "OPC Event Server is unavailable or does not exist" messages. To 

disable these messages, edit the IcoSetup64.ini file and add or modify these entries: 

 

[AWX\AWXServer] 

EnableWarning=false 

 

[GENBROKER\GenClient] 

SendEventMessages=0 

 

Note: Systems where these messages are disabled should implement some other way to notify the users or system 

administrators that a failover has occurred so that the problem that caused the failover should be addressed. A 

failover that is completely silent may leave the system in a vulnerable state, where only one alarm server is 

functioning and there is no functional backup. 

83684 
The Key field is no longer present in the Reporting table under Platform Services Configuration > Basic Tab. A key is 

no longer required to configure these reverse network connections. 
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Global Search 

Ref ID Description 

49749 

Global search indexes can now repeat at a specific time of day, rather than a given interval. Indexing can take a lot of 

system resources and being able to specify the time of day allows users to schedule it when it causes the least impact 

to users. 

Installation 

Ref ID Description 

83829 
The ICONICS Suite installation no longer asks for a Facility AnalytiX serial number by default. To specify a Facility 

AnalytiX serial number, make sure to select Facility AnalytiX on the suite selection page. 

85698 

In the database creation options, the "Silent Configuration" option has been renamed to "Advanced Configuration". 

When the user selects Advanced Configuration, an additional dialog will appear towards the end of the installation to 

offer more advanced database configuration options.  

 

In previous versions, this dialog would appear by default. Now, the dialog only appears when the user specifically 

selects "Advanced Configuration". 

Licensing 

Ref ID Description 

78056 

The ICONICS License Service is now configured by default to start as Automatic (Delayed). This change resolves an 

issue that has been observed on some systems where the License Service would not start after a reboot, causing 

clients such as Workbench and GraphWorX64 to display keys or a license failure message. 

84855 

In previous versions, only PresentValue BACnet tags were only counted as points with a GENESIS64 Advanced license. 

 

Now, instead of counting the PresentValue tags, unique BACnet objects are counted as a point. In most cases, this 

should result in no change to the number of points a GENESIS64 Advanced system consumes from BACnet usage, 

but the point count may go up slightly if there were objects where the PresentValue point was not subscribed but 

other points were. 

 

This method of counting unique BACnet objects is the same whether BACnet Classic or BACnet with SC is used. 

 

GENESIS64 Basic SCADA point counting has not changed with regards to BACnet. 

OPC UA 

Ref ID Description 

65289 
FrameWorX now limits the number of items per various operations as requested by OPC UA servers that may expose 

these limits. This prevents ICONICS clients from overloading an OPC UA server by obeying its limits. 

83452 

83459 

In past releases, the default behavior was that when FrameWorX connected to an OPC UA server, the connection 

would succeed even if the server's certificate was not trusted. This has been changed - the default behavior is now 

that certificate must be trusted for the connection to succeed.  

 

This new default behavior is more secure and in line with recommendations by the OPC Foundation, but systems 

upgrading to this version may discover that they can no longer connect to their OPC UA servers until the certificate is 

trusted. 

 

Trusting certificates is easier in this version. When adding or configuring an OPC UA server under Data Connectivity > 

OPCUA > OPC UA Network, users can select the "Configure" icon for the server, then select Test Connection. If the 

connection fails due to an untrusted certificate, a message will appear asking the user if they would like to trust the 

certificate. 

83486 

If the issuer of a UA certificate is rejected because it is not trusted, the entire chain of certificates is copied into the 

rejected certificates folder on the client. Previously, only the original certificate would be copied into the rejected 

certificates folder. (Chain certificates must be available in the Windows store to be copied.) 
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Project Reporting 

Ref ID Description 

83135 

All datasets under Diagnostics > Configuration > Availability and Entities are now secured by the applicable 

Workbench application actions. For example, datasets under Entities > SNMP can only be seen by a user granted the 

Workbench > SNMP > Browse Items Application Action. 

Security 

Ref ID Description 

81089 

Data browsing can now be secured with ICONICS security. When configuring the permissions for a group or user, the 

Points tab contains a Browse column in addition to the Read and Write columns. Users without browse permission 

will be unable to see the matching tags and folders in the data browser and in search results. 

81975 

Different alarm operations, such as shelve, latch reset, and accept can now be secured. 

 

To configure the security for these alarm operations, select a user or group under the Security provider, then go to 

the Alarms tab. In the Allow or Deny table, add a new item, then select the "Click to select alarm options tag" button. 

A dialog will appear, allowing you to browse for an alarm or area and also select an operation. Browse for the alarm 

tag, select an operation, then select OK. A security string representing that alarm tag and that operation will be 

added.  

 

An example security string that can be used to secure the ShelvedOn operation for an alarm is: 

alms:/Area.Tag|StateOperation=ShelvedOn 

 

Wildcards can still be used. For example, this security string will control the ShelvedOn action for all alarm tags: 

 

*|StateOperation=ShelvedOn 

 

Note, when an operation is specified in the security string, only the "Ack" column's checkbox applies. The View 

checkbox is ignored. To control whether a user can view alarms, specify the alarm tag (or a wildcard) with no 

operation specified. 

 

Also note, the AlarmWorX64 Server supports writing to specific data points to acknowledge alarms. These points 

must be secured separately using the Points tab. Failing to secure these points could give a user the ability to 

acknowledge an alarm, even if the Alarms tab denies acknowledgment for that alarm. 

TraceWorX 

Ref ID Description 

40081 It is now possible to sort the TraceWorX modules by different headers by clicking on that header. 

64657 Added a Disable All Tracing button that allows the user to quickly disable tracing for all modules at once. 

83587 Added a start menu shortcut to the TraceWorX Log Viewer under ICONICS Tools. 

Web Platform Services (WebAPI) 

REST Provider 

Ref ID Description 

78064 The WebAPI's REST provider can now support real-time and historical alarms. 
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AnalytiX 

AnalytiX-BI 

Ref ID Description 

74966 

The dayofweek and dayofweekoffset functions have been added to the BI Server. 

 

Dayofweek returns a value from 0 to 6, representing the day of the week where 0 is Sunday, 1 is Monday, etc. This 

example query will aggregate the results by the day of the week for a given month. 

 

SELECT SUM(od.UnitPrice), dayofweek(o.OrderDate) FROM OrderDetails AS od INNER JOIN Orders AS o ON 

od.OrderID = o.OrderID  WHERE year(o.OrderDate) = 1996 AND month(o.OrderDate) = 7 GROUP BY 

dayofweek(o.OrderDate) 

 

Dayofweekoffset returns a similar value of 0 to 6 but will sort the days according to the data model default collation. 

It is designed to be used when sorting. For example, adding an ORDER BY clause to the above query: 

 

SELECT SUM(od.UnitPrice), dayofweek(o.OrderDate) FROM OrderDetails AS od INNER JOIN Orders AS o ON 

od.OrderID = o.OrderID  WHERE year(o.OrderDate) = 1996 AND month(o.OrderDate) = 7 GROUP BY 

dayofweek(o.OrderDate) ORDER BY dayofweekoffset(o.OrderDate) 

 

This will order the data with the first day of the week as Sunday when using en-us as a culture, and as Monday when 

using it-it. 

 

KPIWorX can access this DayOfWeek dimension when browsing AnalytiX-BI data. 

82764 
For data flows, added a new "Data Processing" section to the Hyper Historian Aggregated Data step. This section 

allows users to specify the percent good and percent bad values for the aggregate. 

85467 

Added optional query plan cache. Caching query plans can provide a small performance improvement on systems 

where the tables are smaller (thousands or tens of thousands of rows) and the average query execution is in the tens 

of milliseconds.  

 

The query plan cache is off by default and can be enabled in Platform Services Configuration > Point Managers > BI 

Server Point Manager by setting EnableQueryPlanCache to True. 

BridgeWorX64 & Workflow 

Common 

Ref ID Description 

60003 
Added a new activity block: Historical Upload. This block allows users to take a dataset from a previous activity block 

and import it into a historical tag. 

82819 

Previously, the failure or success of the AlertWorX action was not visible to BridgeWorX64 or CFSWorX. These 

included activities such as Email, Twilio Message, SendGrid Email, etc. Once the request from one of these blocks got 

to AlertWorX, it would be considered successful, regardless of the status of the actual alert being sent from 

AlertWorX. The block would report a success and follow the success path. An activity could retry if it failed sending 

the request to AlertWorX, but once AlertWorX got the request it would not retry further, even if the alert failed in 

AlertWorX. 

 

The status of the AlertWorX actions are now visible to BridgeWorX64 and CFSWorX activity blocks. The visibility of 

the AlertWorX status means that the "retry" functionality of activity blocks can now be used to resend failed 

AlertWorX messages. The activity blocks can also follow the "fail" path and report a failure to the transaction trace 

based on the AlertWorX status. They will also wait for the success or failure of the alert (or for the configured timeout 

period of the activity) before proceeding to the next activity. 
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BridgeWorX64 Server 

Ref ID Description 

85097 

BridgeWorX64 configuration objects can now set a default Acknowledge Code. When transactions in this 

configuration invoke AlertWorX actions that support acknowledgment, the user acknowledging the alarm must enter 

this acknowledge code. 

 

This setting is located in the Advanced Properties section of the BridgeWorX64 configuration object, located under 

Bridging > Transactions. 

BridgeWorX64 Workbench Provider 

Ref ID Description 

84068 
The expression editor in Workflows, BridgeWorX64, and CFSWorX templates now contains a tree of related variables. 

This gives the user easier access to trigger data, alarm data, internal variables, and more. 

Workflows Workbench Provider 

Ref ID Description 

84068 
The expression editor in Workflows, BridgeWorX64, and CFSWorX templates now contains a tree of related variables. 

This gives the user easier access to trigger data, alarm data, internal variables, and more. 

CFSWorX 

General 

Ref ID Description 

85102 

CFSWorX configuration objects can now set a default Acknowledge Code. If an acknowledge code is not available 

when invoking AlertWorX actions that support acknowledgment, this acknowledge code will be used instead. 

 

This setting is located in the Advanced Properties section of the CFSWorX configuration object, located under 

Connected Field Worker > Field Workflows. 

CFSWorX Workbench Provider 

Ref ID Description 

83264 Minor UI updates to the CFSWorX template editor. 

83290 

A pause can be added to the Twilio voice message. In the Connected Field Worker template, in the Twilio Voice 

Message activity, edit the Message field and add the "Pause(x)" where you would like a pause. Replace "x" with the 

number of seconds you would like to delay. (For easy reference, this syntax is displayed in the shortcuts section of the 

Twilio Voice Message activity.) 

84068 
The expression editor in Workflows, BridgeWorX64, and CFSWorX templates now contains a tree of related variables. 

This gives the user easier access to trigger data, alarm data, internal variables, and more. 

84501 

For SendGrid Configurations, the Verify Key button is now only enabled if the email field is filled. Also, the Test Email 

button will only be enabled once the email has been verified. The UI has been modified slightly to help users 

understand that these fields are required. 

Workflows and Alerts 

Ref ID Description 

84067 

The sample Connected Field Worker configuration database now contains example Field Workflows to subscribe to 

FDDWorX and Hyper Alarm Server. Previously, the only Field Workflow available was configured to subscribe to 

AlarmWorX64 Server. 
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Energy AnalytiX 

Ref ID Description 

82263 

Unpacking the Energy AnalytiX package file can now set the KPIWorX dashboard icon and order in the navigation 

tree sidebar. This will override the information about any existing dashboards in the navigation tree. (Dashboards in 

the tree will remain there, but the order and icon will revert to default settings.) 

 

Users who do not want to override their navigation tree information can exclude the KPIWorX index file 

(KPIXStorage\kpix.index) while unpacking. 

83289 Enhanced the efficiency of the AnalytiX-BI data model used by Energy AnalytiX dashboards. 

Facility AnalytiX & FDDWorX 

Ref ID Description 

79719 Facility AnalytiX and FDDWorX can now support Azure Active Directory and SQL Azure. 

Fault Viewer 

Ref ID Description 

86164 
The Table and Fault Viewer controls now support the Min and Max aggregates for Boolean columns. Previously 

Boolean columns only supported the Count aggregate. 

FDDWorX Workbench Provider 

Ref ID Description 

83542 
The configuration of OPC UA servers has been moved from Platform Services to Data Connectivity > OPC UA > OPC 

UA Network. 

ReportWorX64 & ReportWorX64 Express 

Ref ID Description 

83207 
It is now possible to upload XLSM templates to the report template configuration in Workbench. Note, macros will 

not be executed by the ReportWorX64 Server when generating reports. 

ReportWorX64 Express & Excel Add-In 

Ref ID Description 

81528 Improved the wording of some error messages to make them clearer to the user. 

83900 Parameters of type "Automatically evaluate a date and time" can now use "Months" in the Offset Range. 

Data Connectivity 

BACnet Connector 

BACnet Classic 

Ref ID Description 

84855 
In previous versions, only PresentValue BACnet tags were only counted as points with a GENESIS64 Advanced license. 
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Ref ID Description 

Now, instead of counting the PresentValue tags, unique BACnet objects are counted as a point. In most cases, this 

should result in no change to the number of points a GENESIS64 Advanced system consumes from BACnet usage, 

but the point count may go up slightly if there were objects where the PresentValue point was not subscribed but 

other points were. 

 

This method of counting unique BACnet objects is the same whether BACnet Classic or BACnet with SC is used. 

 

GENESIS64 Basic SCADA point counting has not changed with regards to BACnet. 

GridWorX (Databases) 

GridWorX Server 

Ref ID Description 

83346 GridWorX Server no longer supports SAP connections. 

GridWorX Viewer 

Ref ID Description 

81388 

The delimiter for CSV files exported from an AlarmWorX64 or GridWorX Viewer can now be configured by the user. 

Configure the viewer, select the grid or chart object, go to the Advanced tab, then edit the CsvReportSeparator 

property (in the Common section). The default separator is a comma. 

SNMP Connector 

Ref ID Description 

85533 

Previously, the Multiple Get Count setting only applied to devices that were configured for SNMP v2 or v3. Now, this 

property also applies to SNMP v1 devices. In Workbench, this setting has been moved from the "SNMP v2 Settings" 

section to the "Timing" section on an SNMP device. 

 

The Multiple Get Count setting determines the maximum number of variables that the server will attempt to retrieve 

in a single SNMP request. Increasing this value can improve performance on systems with an extremely large number 

of properties (thousands), but could increase errors, as a failure of any variables in a single request may result in a 

failure of the entire request. 

Web Services Connector 

Ref ID Description 

85901 

The token type "Bearer" will now be added by default to web service requests when no token type was returned from 

the server during authentication. This allows us to communicate with web services that do not return a token type 

when authenticating. (This situation should be rare, as web services should return a token type during 

authentication.) 
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GENESIS64 

Alarms and Notifications 

AlarmWorX64 Logger 

Ref ID Description 

53733 

These performance counters have been added to help monitor a redundant AlarmWorX64 Logger system. They are 

available in both the Windows Performance Monitor and in ICONICS Suite under Diagnostics > Control and 

Diagnostics > System Performance Counters 

 

ICONICS AlarmWorX64 Logger Server/Store and Forward Files Creation Count 

ICONICS AlarmWorX64 Logger Server/Store and Forward Files Primary Count 

ICONICS AlarmWorX64 Logger Server/Store and Forward Files Removal Count 

ICONICS AlarmWorX64 Logger Server/Store and Forward Files Secondary Count 

ICONICS AlarmWorX64 Logger Server/Successful Logs to Primary Count 

ICONICS AlarmWorX64 Logger Server/Successfull Logs to Secondary Count 

61699 
Enhanced AlarmWorX64 Logger redundancy performance, especially in cases where two redundant logging 

databases were used, and one database was offline. 

75458 

In previous versions, many fields of the AlarmWorX64 Logger were limited to 255 characters. This limit can now be 

extended to the maximum allowed by SQL Server. The default behavior is to enforce the 255 character limit. Users 

who wish to extend this limit must do two things. 

 

First, the IcoSetup64.ini must be edited to add or modify this field: 

 

[AWX\AWXLog] 

LegacySize=0 

 

Second, the logging table must support the longer data types. New logging tables created in this version will use the 

longer data types by default. Existing logging tables must be modified manually. For existing databases, modify the 

table where alarms or events are being logged and change all columns type that have a type of NVARCHAR(255) to 

NVARCHAR(MAX), especially the Message column. 

AlarmWorX64 Server 

Ref ID Description 

83444 

Added a new INI setting to reduce incidents where both AlarmWorX64 Servers in a redundant pair have valid but 

non-identical sets of data. This is known as "split-brain". This can occur when the source data is remote from the 

alarm servers and each alarm server receive different updates from the source data (perhaps because of network 

inconsistencies). This new setting sacrifices availability to help prevent split-brain issues from occurring. Contact 

technical support for information on how to implement this setting if you think you have having split-brain issues. 

AlarmWorX64 Viewer 

Ref ID Description 

81388 

The delimiter for CSV files exported from an AlarmWorX64 or GridWorX Viewer can now be configured by the user. 

Configure the viewer, select the grid or chart object, go to the Advanced tab, then edit the CsvReportSeparator 

property (in the Common section). The default separator is a comma. 

AlertWorX 

Ref ID Description 

60546 

AlertWorX email and pager agents now have better support for online changes. Previously, these agents only 

recognized configuration changes on an AlertWorX service restart or when the agent was tested. Now email and 

pager agents periodically check for changes while running. (This is now consistent with most of our other Workbench 

providers and point managers.) 
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Ref ID Description 

81073 
The voice and language settings for Twilio voice messages can now be customized. When configuring a Twilio 

Configuration object, set these values in the Voice Customizations section. 

81595 

The configuration of the email notification settings of AlertWorX Email and SMS/Text nodes has been moved to a 

new tab named Message Settings. In addition, a new checkbox has been added to this tab to enable or disable the 

message-on-alarm feature. We hope this UI change will make it clearer to users what the message settings are for 

and how AlertWorX will use them. 

82072 

82073 
Expressions can now be used in AlertWorX email subject and body fields. 

82074 
Email and text nodes now contain an "Enable the node" checkbox. Disabling this box will prevent the email or text 

from being sent to this node. 

83290 

A pause can be added to the Twilio voice message. In the Connected Field Worker template, in the Twilio Voice 

Message activity, edit the Message field and add the "Pause(x)" where you would like a pause. Replace "x" with the 

number of seconds you would like to delay. (For easy reference, this syntax is displayed in the shortcuts section of the 

Twilio Voice Message activity.) 

Hyper Alarm Server 

Ref ID Description 

49272 

Alarms in a particular area or globally can now be acknowledged using the Call Method command.  

 

For the Call Method's "Name" parameter, browse for one of these methods in the Hyper Alarm Server: Acknowledge, 

LatchReset, OutOfServiceOff, OutOfServiceOn, ShelvedOff, ShelvedOn, SuppressedByDesignOff, 

SuppressedByDesignOn. All methods can take one parameter for the comment. The ShelvedOn method can also take 

another parameter for the shelve time in seconds. 

 

Note that the operation will be applied to every alarm in the chosen area, even inactive alarms. 

 

This provides similar functionality to the AlarmWorX64 Server, which used to provide realtime tags that could be 

used to acknowledge alarms globally or in a particular area. 

68444 

In a non-redundant setup, Hyper Alarm Server now remembers the state of the alarms (including acknowledgment, 

shelved, etc.) after the service has been restarted. (On a redundant system, the running member of the pair will 

remember the states while the other restarts.) 

AssetWorX 

Asset Navigator 

Ref ID Description 

57687 

There is a new option for the List Mode settings called "Start Empty". When selected, the Asset Navigator will display 

an empty list when the List Mode Parent data source resolves to an empty string. 

 

This new setting makes it easier to configure connected asset navigators. With this setting unchecked the "child" 

navigator would start showing the children of the configured root, which could be confusing to a user. Now, when 

"Start Empty" is enabled, the "child" navigator can start empty, as expected, and return to empty if the selection in 

the "parent" navigator is cleared. 

 

Note, the List Mode settings have been moved from the General tab to the new Navigation tab. There is a new 

section called List Mode. The new Start Empty setting is found here. 

Query Interface 

Ref ID Description 

83535 

Equipment properties can now be used as a field and listed as a column in the Table control (and other controls that 

support the Query Interface).  
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Ref ID Description 

In the Table control, when using a Type of Query, Data Source of ac:.Query, and Table of Equipment, on the Fields tab 

you can select the + button and then Browse. In the browser, select one of the equipment properties. That property 

will now be available as a field, able to be added to the Columns tab or used in filters or styling. Note, any asset that 

does not have this property will return a blank value for this field. 

83536 

The AssetWorX Query Interface tables can now return fields for each level of the asset path. These fields are named 

".EquipmentPath[N]" where N is the level of the asset path (starting at zero). There are also a set of fields that provide 

the level in the reverse order: ".EquipmentPathReversed[N]". 

 

For example, if an asset has a path of "Building/Floor/Room/", the ".EquipmentPath[0]" field will be "Building", 

".EquipmentPath[1]" will be "Floor", and  ".EquipmentPath[2]" will be "Room". The ".EquipmentPathReversed[N]" field 

will be the same, but in the reverse order, so  ".EquipmentPathReversed[0]" will be "Room". 

 

If an asset doesn't have a path long enough, the extra fields will show as blank. In the above 

example, .EquipmentPath[3] will be blank. 

 

In the Table control (and other controls that support the Query Interface), these fields can be added by selecting the 

+ button and choosing "Browse". At the bottom of the browse list, expand either ".EquipmentPart Path" or 

".EquipmentPath Reversed Part" and choose the desired field to add. 

84793 

The AssetWorX "Equipment" Query Interface table now provides a field for ".Commands". When this field is mapped 

to a column in the Table control, users can choose a content type of "Commands" to display this column as a set of 

buttons. These command buttons function like the command buttons displayed in the Asset Navigator, allowing 

users to execute commands configured on the asset in question. 

85493 

The in the AssetWorX Equipment table, .ParentEquipmentPath field of the root asset now returns an empty string ("") 

instead of a null value. This allows for easier filtering. 

 

(The Equipment table can be accessed by controls that use the Query Interface, such as the Table control. To access 

the Equipment table in the Table control, set the Type to Query, the Data Source to ac:.Query, and the Table to 

Equipment.) 

Controls 

Camera Control 

Ref ID Description 

38667 

Improved the behavior of the desktop (WPF) camera control when the camera feed was offline. 

 

Previously, if the camera feed was offline when the display loaded or became offline after that, no retries would be 

made to reestablish the feed. The last displayed image (or a black screen, in the case that no image had been loaded) 

would remain on the screen indefinitely until the display was reloaded. There was no indication whether the image 

was simply not changing or if it was frozen due to the feed being offline. 

 

Now, the WPF camera control will periodically try to reconnect if the camera had been offline. If an image had been 

loaded, it will be replaced by a black screen after a configurable timeout period (set by the RenderingTimeout 

property) to visually indicate that the camera is offline. 

 

Note, the behavior of the HTML5 camera control is unchanged, and may vary based on the browser. 

Data Diagram 

Ref ID Description 

60308 

The sort order of the data diagram's horizontal and vertical axes can now be customized. On the Columns or Rows 

page, select Sorting. For Comparison Expression, select the small square on the right and choose from either 

Alphabetic, Numeric, or Date sorting. The user can also supply their own expression to create a custom sorting order. 

75258 
The data diagram's tooltips now use the font settings on the Style page and the Window Background and Window 

Foreground colors in the Child Controls Style section. 
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Ref ID Description 

82253 

Styling rules can now be applied to the Data Diagram. This can improve the readability by allowing the user to specify 

different foreground colors for different cells. It can also be used to highlight cells that have an error condition or 

other unusual circumstance. 

 

Go to the Rules page to configure styling rules for background and foreground colors. 

83899 Small improvements to the performance of the desktop (WPF) Data Diagram. 

83914 More color palettes have been added to the Data Diagram's configuration ribbon. 

EarthWorX Viewer 

Ref ID Description 

29193 
Improved the feedback in the map connection manager and TraceWorX to help users identify an issue with the 

credentials for their map tiles. 

Table Control 

Ref ID Description 

70422 

70423 

When using a microchart column, the microchart axis can now be displayed at the bottom of the table in addition to 

or instead of the axis at the top. To display the bottom axis, edit the control, go to the Controls page, and enable the 

footer. 

  

The footer can be enabled in both the Table and Fault Viewer controls. As of this version, this footer is only used for 

the microchart axis. 

79086 
The user can now specify the point fail text for data displayed in the table control. The point fail text is configured on 

the General tab in the Data section. The point fail text only applies to columns of type DataSource. 

79726 The runtime filtering of the Table control now supports checkbox filters. 

83535 

Equipment properties can now be used as a field and listed as a column in the Table control (and other controls that 

support the Query Interface).  

 

In the Table control, when using a Type of Query, Data Source of ac:.Query, and Table of Equipment, on the Fields tab 

you can select the + button and then Browse. In the browser, select one of the equipment properties. That property 

will now be available as a field, able to be added to the Columns tab or used in filters or styling. Note, any asset that 

does not have this property will return a blank value for this field. 

83897 

Columns can be optionally excluded from the export of the Table control. To exclude a column, configure the control, 

go to the Columns tab, select the column you'd like to exclude from the export, and uncheck the new "Exportable" 

property. This property is enabled by default. 

84793 

83537 

The AssetWorX "Equipment" Query Interface table now provides a field for ".Commands". When this field is mapped 

to a column in the Table control, users can choose a content type of "Commands" to display this column as a set of 

buttons. These command buttons function like the command buttons displayed in the Asset Navigator, allowing 

users to execute commands configured on the asset in question. 

86164 
The Table and Fault Viewer controls now support the Min and Max aggregates for Boolean columns. Previously 

Boolean columns only supported the Count aggregate. 

TrendWorX64 Viewer 

Ref ID Description 

85837 

The Time Format field on the X Axis tab of a Chart can now accept an expression. Use the {{@@timestamp}} context 

variable in the expression to represent the time value of the axis. A more ("...") button has been added to this field to 

open the expression editor. From this expression editor, the {{@@timestamp}} context variable can be found under 

Variables > Context Variables tab. 

 

These expressions allow users great flexibility over the X Axis labels, such as displaying the time as a number of 

seconds in the past, rather than a standard timestamp. 

 

Note, Time Format expressions are only supported by the data export feature when the "General Time Settings" are 

not inheriting from the X axis. When the time settings are inherited from the X axis, a default time format will be used 

in the export. 
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GraphWorX64 

Ref ID Description 

11122 

83221 

Process points now support password masking. A configured process point will have its contents obscured by dots. 

Optionally, a masked process point can also be hashed. This hashing is necessary when setting passwords with the 

new Configure Security command. 

 

To mask a process point, ensure GraphWorX64 is in Advanced Mode (View > Application Mode > Advanced Mode), 

then set the Password property to True.  

 

To also hash a process point, in addition to setting Password to True, set PasswordHashing to Password-Based Key 

Derivation Function 2. When PasswordHashing is configured, the value written by the user will be hashed before 

being written to the data source. 

 

The Password and PasswordHashing properties work in both desktop (WPF) and HTML5 clients. 

24597 A refresh option has been added to the context menu of the symbol library. 

26780 

If the Target property of a command is specified but is currently bad quality, the pick action will be disabled or the 

command will not execute. In previous versions, it acted as if there was no Target specified (meaning if may have 

popped up a menu of available targets). 

33848 
It is now possible to update the value of a localsim:property tags representing brush properties, for example, the 

background property of a shape. Previously, these tags could be read, but not modified. 

38117 

Added a new "Add Grid Page" option to the Pivot control's configuration ribbon. The previous "Add Page" button 

has been renamed to "Add Layer Page". 

 

Note, it was possible to add a page with a grid layout to a Pivot control previously, but this button makes the process 

easier and more intuitive. 

46111 

85038 

GraphWorX64 displays and viewers can now be the target of the Go To Location and Zoom commands. Previously 

these commands were only able to target an EarthWorX Viewer. 

 

For Zoom, GraphWorX64 only uses the Unit and Zoom properties. 

 

For Go To Location, the Latitude and Longitude properties are the Y and X location, respectively, for the desired view 

location. The Unit and Zoom properties behave consistently with the Zoom command. Leave the Zoom property 

blank to not modify the zoom level. 

46226 

When nesting a classic smart symbol (smart symbol created from a group) inside a grid smart symbol (smart symbol 

created from a grid panel) or vice versa, the child smart symbol can now read smart property values from the parent 

smart symbol. 

46630 
File selection dialogs, such as the one in the Search and Replace dialog, now show a loading cursor when processing 

a large list of files. 

47266 

The StartPercent and EndPercent properties of size dynamics can now be set to greater than 100%. This allows size 

dynamics to enlarge an object. Previously, size dynamics could only shrink objects. Note, this only applies to size 

dynamics where the Bias and Clip properties are both false. 

49380 Users can now preserve visibility of objects when updating shared objects. 

57386 

Custom views can now be sorted alphabetically in ascending or descending order. To sort custom views, in configure 

mode, go to the View ribbon, select Custom Views > Order Views and choose either Ascending or Descending. 

 

(Custom views can still be sorted manually in the Edit Views editor.) 

68693 

84017 

Writable GraphWorX64 process points have a new property called CommentRequired. When CommentRequired is 

true and the Confirm and Comment properties are also true, the user must enter a non-empty (non-whitespace-only) 

comment to be logged for the written value. (The CommentRequired property is ignored when either the Confirm or 

Comment properties are false.) 

 

CommentRequired is only visible in Advanced mode. 

 

This has been implemented for both desktop (WPF) and HTML5 platforms. 

70055 GraphWorX64 now logs GenEvent messages when displays are loaded in runtime or configuration mode. 

79245 
Improved performance for point fail or disabled color switching. This performance improvement is most noticeable 

on systems that have thousands of objects that need to show point fail or disabled colors. 
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Ref ID Description 

82788 

These properties of a pick action with a Command of "Load Display" (local command) can now be edited in "Web 

Browser" edit mode: 

 

* TargetType: Popup Window (Independent) 

* OverrideWindowProperties 

* WindowProperties: Left, Top, Width and Height values 

 

This allows users to configure popup windows for HTML5 displays. This feature was added in 10.97 but was only 

configurable when in "Desktop App" edit mode. (Note, these popup windows are only supported in platforms that 

support window positioning.) 

83030 
The import and export functionality of the Edit Process Point States dialog now exports the DataSource property of 

the state objects, if present. 

Web Publishing Wizard 

Ref ID Description 

41708 

A new set of radio buttons has been added to the Web Publishing Wizard's Publishing Options page. The group is 

called "Access Protocol". These buttons allow the user to configure which protocol will be used in the HTM files 

created by the Web Publishing Wizard. This can be useful if the user is using a different method for publishing and 

viewing the files. 

 

The "Access Protocol" option has these three settings: 

 

Default: The HTM file will use the behavior from previous versions, which is that the protocol will be inferred from the 

web server configuration (set on the Select a Publishing Location page). 

 

http: The HTM file will use http, regardless of the chosen web server configuration. It will still use the web server's 

port, if one is specified. 

 

https: The HTM file will use https, regardless of the chosen web server configuration. It will still use the web server's 

port, if one is specified. 

ScheduleWorX64 

Ref ID Description 

44563 
Added new GenEvent messages that will be posted by the ScheduleWorX64 Point Manager when a schedule change 

is made in runtime. The messages indicate the properties that have been changed. 

Hyper Historian 

Hyper Historian Workbench Provider 

Ref ID Description 

81930 

Under Historical Data > Hyper Historian > System Administration > System Settings on the Options tab, there is a 

new section called "Data Exporter Settings" that includes an option called "Concurrency Level". The Concurrency 

Level sets the number of data exporter tasks that are allowed to run at one time. It can take a value between 1 and 

100. The default value is 1, which means the first data exporter task must finish before the second is allowed to run. A 

value of 2 means two data exporter tasks can run at a time, and a third has to wait for one of the current two to 

finish, etc. 

 

A higher concurrency number may improve the export speed in cases where multiple requests for exporting data are 

triggered at the same (or nearly the same) time. However, a higher concurrency number will use more resources of 

the host system where the data exporter is running and on the target storage system where data is being exported 

to. Also, the more data being exported at one time, the higher network utilization can be between the Hyper 

Historian system and the target storage system.  
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Ref ID Description 

So, users should be aware of their system resources and network utilization if they decide to increase the 

Concurrency Level of their data exporter system. They may want to increase the setting slowly, one level at a time, 

and monitor the system closely to ensure the system continues to perform as desired while multiple data export tasks 

are running. 

85276 

Newly created loggers now have a "Starting at" time of January 1, 2000 at 12:00:00 PM.  

 

Previously, the "Starting at" date of loggers was the date at which the logger was created, however this could cause 

some undesirable behavior if the date wasn't changed. For example, importing data that was logged before the 

logger's creation would fail to import. We hope this new "Starting at" time will eliminate such issues. 

Logger 

Ref ID Description 

77115 
The Hyper Historian UA server now supports the GeneralModelChangeEventType event. This means UA clients to 

Hyper Historian will now be notified when the address spaces changes (such as when a new tag is added). 

MergeWorX 

Ref ID Description 

18722 

Adding the text "(disabled)" to the end of a MergeWorX plugin name will disable the plugin. This text is case-

insensitive. 

 

Example name: "My plugin (disabled)" 

 

This is designed to be used for debugging purposes only. For example, when adding a new plugin, all other plugins 

can be disabled to allow testing the new plugin in isolation. 

IoTWorX & Internet of Things 

Ref ID Description 

81592 

The IoT Subscriber can now connect to the Basic Tier Azure IoT Hubs. 

 

Note, for full support of IoTWorX devices, an S1 Tier is still required. However, the IoT Subscriber can now consume 

data from third party devices using the Basic Tier. 

81736 
Most IoTWorX functionality has been condensed into a single container. This improves the efficiency of the edge 

device, uses less storage, and allows us to support Microsoft Azure Stack Edge. 

KPIWorX 

Ref ID Description 

53747 

It is now possible to drag an asset onto a symbol widget and KPIWorX will attempt to map the properties of the asset 

to the properties of the widget with the same name. For example, if an asset with a property named Temperature was 

dragged onto a symbol widget that also had a property named Temperature, the Temperature property of the asset 

would be bound to the Temperature property of the symbol. 

68257 Global search is now available on the Asset Navigator tab of the Data Browser panel. 

74966 

The dayofweek and dayofweekoffset functions have been added to the BI Server. 

 

Dayofweek returns a value from 0 to 6, representing the day of the week where 0 is Sunday, 1 is Monday, etc. This 

example query will aggregate the results by the day of the week for a given month. 

 

SELECT SUM(od.UnitPrice), dayofweek(o.OrderDate) FROM OrderDetails AS od INNER JOIN Orders AS o ON 

od.OrderID = o.OrderID  WHERE year(o.OrderDate) = 1996 AND month(o.OrderDate) = 7 GROUP BY 

dayofweek(o.OrderDate) 
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Ref ID Description 

Dayofweekoffset returns a similar value of 0 to 6 but will sort the days according to the data model default collation. 

It is designed to be used when sorting. For example, adding an ORDER BY clause to the above query: 

 

SELECT SUM(od.UnitPrice), dayofweek(o.OrderDate) FROM OrderDetails AS od INNER JOIN Orders AS o ON 

od.OrderID = o.OrderID  WHERE year(o.OrderDate) = 1996 AND month(o.OrderDate) = 7 GROUP BY 

dayofweek(o.OrderDate) ORDER BY dayofweekoffset(o.OrderDate) 

 

This will order the data with the first day of the week as Sunday when using en-us as a culture, and as Monday when 

using it-it. 

 

KPIWorX can access this DayOfWeek dimension when browsing AnalytiX-BI data. 

MobileHMI & HTML5 WebHMI 

HTML5, iOS, Android 

Ref ID Description 

77963 

Added a configurable timeout period for displays to disconnect. Users who see unexplained display refreshes may 

want to increase this value, however setting it too large (over 30 seconds) may result in higher memory demand. To 

change this timeout, edit the ICONICS\GENESIS64\WebSites\AnyGlass\Bin\ico.anyglass.serviceEngine.config file and 

set the DisposeTimeout value. 

80434 
The HTML5 security control now accepts the enter key as a shortcut for the login button. This is consistent with the 

desktop (WPF) security control. 

85547 
The global Load Graphics Display command was enhanced in HTML5 to support the same types of popups as the 

local Load Display command. 

AlarmWorX64 Viewer 

Ref ID Description 

85961 

Users now have the option to change the behavior of the HTML5 AlarmWorX64 Viewer sorting when selecting 

multiple columns. The default behavior is unchanged from previous versions and is that selecting multiple columns 

for sorting will sort on all selected columns. Users now have the option of changing this behavior so that selecting 

multiple columns for sorting will only sort on the last selected column. (Sorting on only the last column is consistent 

with the desktop (WPF) AlarmWorX64 Viewer.) 

  

To change this behavior, edit the \GENESIS64\WebSites\AnyGlass\Bin\ico.anyglass.parsing.config file and set 

AwxForceSortBySingle equal to "true". 

GraphWorX64 

Ref ID Description 

11122 

Process points now support password masking. A configured process point will have its contents obscured by dots. 

Optionally, a masked process point can also be hashed. This hashing is necessary when setting passwords with the 

new Configure Security command. 

 

To mask a process point, ensure GraphWorX64 is in Advanced Mode (View > Application Mode > Advanced Mode), 

then set the Password property to True.  

 

To also hash a process point, in addition to setting Password to True, set PasswordHashing to Password-Based Key 

Derivation Function 2. When PasswordHashing is configured, the value written by the user will be hashed before 

being written to the data source. 

 

The Password and PasswordHashing properties work in both desktop (WPF) and HTML5 clients. 
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Ref ID Description 

83190 

Load Display commands in HTML5 displays now support TargetTypes of "Popup Window (Display Dependent)" and 

"Popup Window (Display Dependent - Modal)". These popup displays will appear as simulated popups, able to be 

moved around and resized but restricted to the boundaries of the parent display. These simulated popups do not 

have the full range of features of WPF popups. For instance, the ribbon, menu, navigation, and status bar are all 

unsupported. 

  

The settings necessary to configure these new popup types are now visible when GraphWorX64 is in Web Browser 

mode. 

86194 

The localsim:property Visibility tag returned values that were not consistent between HTML5 and desktop (WPF), 

meaning it was not possible to use this tag to create displays that behaved the same in both platforms. We were 

unable to reconcile the behavior of this tag, but a the localsim:property tag called "Visible" was added to HTML5. This 

property previously existed in desktop (WPF), and now it behaves the same in HTML5 as well. 

 

Please use the Visible property in displays that are designed to be used in both HTML5 and desktop (WPF) clients. 

Workbench 

Ref ID Description 

78441 The performance of managing IoT projects in Workbench has been improved. 

PowerShell 

Ref ID Description 

85289 
The PowerShell cmdlets Set-SecRole and New-SecRole now expose the IsDefault parameter, which allows the user to 

set whether a group is the default group. 

 



For more, visit iconics.com
© 2021 ICONICS, Inc. All rights reserved. Specifications are subject to change without notice. 
AnalytiX and its respective modules are registered trademarks of ICONICS, Inc. GENESIS64, GEN-
ESIS32, Hyper Historian, IoTWorX, KPIWorX, MobileHMI, WebHMI and their respective modules, 
OPC-to-the-Core, Make the Invisible Visible, and ICONICS company logo, are trademarks of 
ICONICS, Inc. Other product and company names mentioned herein may be trademarks of their 
respective owners. 

Founded in 1986, ICONICS is an award-winning global software provider 
offering real-time visualization, HMI/SCADA, energy management, fault 
detection, manufacturing intelligence, MES, and a suite of analytics 
solutions for operational excellence. ICONICS solutions are installed in 70 
percent of the Global 500 companies around the world, helping customers 
to be more profitable, agile and efficient, to improve quality, and to be 
more sustainable. 

ICONICS is leading the way in cloud-based solutions with its HMI/SCADA, 
analytics, mobile and data historian to help its customers embrace the 
Internet of Things (IoT). ICONICS products are used in manufacturing, 
building automation, oil and gas, renewable energy, utilities, water and 
wastewater, pharmaceuticals, automotive, and many other industries. 
ICONICS’ advanced visualization, productivity, and sustainability solutions 
are built on its flagship products: GENESIS64™ HMI/SCADA, Hyper 
Historian™ plant historian, AnalytiX® solution suite, and MobileHMI™ 
mobile apps. Delivering information anytime, anywhere, ICONICS’ solutions 
scale from the smallest standalone embedded projects to the largest 
enterprise applications.

ICONICS promotes an international culture of innovation, creativity, and 
excellence in product design, development, technical support, training, 
sales, and consulting services for end users, systems integrators, OEMs, 
and channel partners. ICONICS has over 375,000 applications installed in 
multiple industries worldwide.

World Headquarters
100 Foxborough Blvd. 
Foxborough, MA, USA, 02035 

  +1 508 543 8600 
  us@iconics.com

Australia
  +61 2 9605 1333 
  australia@iconics.com

China
  +86 10 8494 2570 
  china@iconics.com 

Czech Republic
  +420 377 183 420 
  czech@iconics.com

European Headquarters
Netherlands

  +31 252 228 588 
  holland@iconics.com

France
  +33 4 50 19 11 80 
  france@iconics.com

Germany
  +49 2241 16 508 0 
  germany@iconics.com

India
  +91 265 6700821 
  india@iconics.com

Italy
  +39 010 46 0626 
  italy@iconics.com

Singapore
  +65 6667 8295 
  singapore@iconics.com

UK
  +44 1384 246 700 
  uk@iconics.com

ICONICS Sales Offices 


	Front Cover
	Contents
	Introduction to What's New
	Structure of the Document
	Security Vulnerabilities

	Most Notable Features
	Major Enhancements
	Common & Platform Services
	Installation
	Language Pack Included in Release
	Secure By Default Installation Secures UA Server
	For Further Reference


	Security
	Use Commanding and Datasets to Configure Security in Runtime
	For Further Reference



	AnalytiX
	AnalytiX-BI
	Performance Enhancements
	Parameterized Views
	For Further Reference

	New Refresh Type: "Update Existing and Insert New Data"
	For Further Reference

	Expanded Query Functionality
	For Further Reference


	BridgeWorX64
	Transactions
	Acknowledgement Support for FDDWorX, Hyper Alarming, and OPC UA


	CFSWorX
	General
	Schedule View in CFSWorX Dashboard
	For Further Reference


	Workflow and Alerts
	Microsoft Azure Communications Services SMS
	For Further Reference

	Send Email using Sendinblue
	For Further Reference

	Acknowledgement Support for FDDWorX, Hyper Alarming, and OPC UA
	For Further Reference


	Worker Access
	Display Geofences and Replay Worker Location Path in EarthWorX
	For Further Reference

	Worker Location Data from ServiceNow and Maximo
	For Further Reference



	Energy AnalytiX
	Various Ease of Use and Accuracy Enhancements
	Data Models and Sample Dashboards Updated to Use New AnalytiX-BI and KPIWorX features

	ReportWorX64
	General
	Allow Users to Select a Tag as a Parameter Value
	For Further Reference

	Preconfigured Parameters
	For Further Reference

	Local and Server Machine Name Parameters
	For Further Reference

	Predefined Parameters for Every Template
	For Further Reference

	Find and Replace in Headers
	For Further Reference

	New Series Column Mode for Charts
	For Further Reference

	Configure Sorting of Data Sources
	For Further Reference

	Parameterized Date Time and Double Formats
	For Further Reference


	ReportWorX 365
	Removing Support for ReportWorX 365



	Data Connectivity
	BACnet Connector
	Technical Preview: BACnet With SC Point Manager
	For Further Reference


	EtherNet/IP Connector
	EtherNet/IP Connector Deprecated
	For Further Reference


	Mitsubishi Electric Factory Automation (FA) Connector
	Support for Additional PLC and GOT Series
	For Further Reference


	OPC UA Connectivity
	Read Support for Structured Variables
	For Further Reference


	Takebishi DeviceXPlorer OPC Server
	Version 6.4.0


	GENESIS64
	Alarms and Notifications
	AlertWorX
	Hyper Alarm Logger
	New Module: Hyper Alarm Logger
	For Further Reference



	Controls
	Data Diagram
	Support for Query Interface

	EarthWorX
	Support for Geofences and Replay of Worker Location Path

	Query Interface
	Technical Preview: Display Historical Data in Table, Data Diagram, Sankey Diagram via Query Interface
	Data Diagram Supports Query Interface


	GENESIS64 Basic SCADA Suite Option
	Updates to GENESIS64 Basic SCADA
	For Further Reference


	GraphWorX64
	Execute Commands on GraphWorX64 Events
	For Further Reference

	Referenced SVG Images
	For Further Reference

	WPF Embedded Web Browser is Now Edge-Based
	For Further Reference



	Hyper Historian
	General
	Technical Preview: Display Historical Data in Table, Data Diagram, Sankey Diagram via Query Interface


	IoTWorX & Internet of Things
	Internet of Things
	MQTT Sparkplug Connector
	For Further Reference

	Easier Configuration for Subscribers of ICONICS and Non-ICONICS Devices
	For Further Reference


	IoTWorX
	IoTWorX Deployment
	Support for Windows Edge Devices using EFLOW
	For Further Reference

	Azure Marketplace Deployment
	Simplified Initial Setup
	For Further Reference

	Hyper Alarming Publishing
	For Further Reference


	Edge Device Data Connectivity
	Takebishi DeviceGateway OPC UA Server Container
	For Further Reference

	MQTT Sparkplug B and OPC UA

	Workbench IoT Projects
	Simplified Configuration and New Options



	WebHMI and MobileHMI
	HTML5 WebHMI and MobileHMI Apps for iOS and Android
	Technical Preview: 3D Viewer Support
	For Further Reference

	Export Image of Display
	For Further Reference

	Feature Parity Improvements
	General
	AlarmWorX64 Viewer
	Camera Control
	Data Diagram
	GraphWorX64
	GridWorX
	Schedule Control
	TrendWorX64 Viewer



	Workbench
	General
	Small Configuration Improvements
	Notification of System User Password Change
	For Further Reference


	Project Reporting
	Additional Reports for Security Configuration
	For Further Reference




	Additional Enhancements
	Common & Platform Services
	Data Browser
	FrameWorX
	Global Search
	Installation
	Licensing
	OPC UA
	Project Reporting
	Security
	TraceWorX
	Web Platform Services (WebAPI)
	REST Provider


	AnalytiX
	AnalytiX-BI
	BridgeWorX64 & Workflow
	Common
	BridgeWorX64 Server
	BridgeWorX64 Workbench Provider
	Workflows Workbench Provider

	CFSWorX
	General
	CFSWorX Workbench Provider
	Workflows and Alerts

	Energy AnalytiX
	Facility AnalytiX & FDDWorX
	Fault Viewer
	FDDWorX Workbench Provider

	ReportWorX64 & ReportWorX64 Express
	ReportWorX64 Express & Excel Add-In


	Data Connectivity
	BACnet Connector
	BACnet Classic

	GridWorX (Databases)
	GridWorX Server
	GridWorX Viewer

	SNMP Connector
	Web Services Connector

	GENESIS64
	Alarms and Notifications
	AlarmWorX64 Logger
	AlarmWorX64 Server
	AlarmWorX64 Viewer
	AlertWorX
	Hyper Alarm Server

	AssetWorX
	Asset Navigator
	Query Interface

	Controls
	Camera Control
	Data Diagram
	EarthWorX Viewer
	Table Control
	TrendWorX64 Viewer

	GraphWorX64
	Web Publishing Wizard

	ScheduleWorX64

	Hyper Historian
	Hyper Historian Workbench Provider
	Logger
	MergeWorX

	IoTWorX & Internet of Things
	KPIWorX
	MobileHMI & HTML5 WebHMI
	HTML5, iOS, Android
	AlarmWorX64 Viewer
	GraphWorX64


	Workbench
	PowerShell



	Back Cover



